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Welcome
Welcome From
From The
The Chief
Chief Editor
Editor
Good things just keep
happening with
PCLinuxOS. The month
of May saw the much
anticipated release of
the PCLinuxOS
OpenBox remaster. We
also saw the first of the
quarterly remasters
released, with
PCLinuxOS 2010.1.
The quarterly updates
for the other remasters
are currently being
worked on by their
respective maintainers.
The steam keeps
building as more and more new users discover what
the rest of us have known all along: the incredibly
stable operating system that we all use, where
everything just flat out works, thanks to the high
standards of Texstar.
The PCLinuxOS Forum is awash with the stories
from users of other Linux distros who have come to
witness and experience PCLinuxOS and Texstar's
magical touch. What greets them is an ever
expanding choice of ISOs from which to choose.
Face it – what other Linux distro offers the user six
different desktop environments, and 11 different
ISOs, all under the same banner? None that I can
think of.
May also saw two more remasters released:
PCLinuxOS 2010 Full Monty by Pinoc, and
PCLinuxOS Power Pack by Sefy. Besides the
PCLinuxOS OpenBox remaster, work has
progressed on a remaster that uses IceWM (Ice

Window Manager). But there is one common thread
between them all: they are all built on the same
common and stable core. Only the desktop
environment varies.
There is no shortage of items to talk about in the
June, 2010 issue of The NEW PCLinuxOS
Magazine. This month, we start a series of articles
on Xfce, and use PCLinuxOS Phoenix 2010 as the
basis for these articles. We start off by taking an look
at what Xfce is, in Xfce 4.6.1: An Overview. We
also start an examination of how to customize and
tailor your Xfce desktop, with Xfce 4.6.1: Xfce
Settings Manager  Part 1. We then tackle a more
advanced topic on how to customize your Xfce
menu, with Xfce 4.6.1: Customizing Your Xfce
Menu.
Meemaw also starts another new series that takes a
closer look at the OpenOffice suite of officerelated
applications, with OpenOffice: An Overview. She
plans to follow up with a look at each of the
components that make up this popular office suite.
We also continue with the other article series that
have been running in the magazine. First, Peter
Kelly continues his tutorial on the command line,
with Command Line Interface Intro: Part 9. Gary
L. Ratliff, Sr. continues his look at computer
programming languages, with Computer
Languages A to Z: Lisp.
Back this month is an article for the gamers of the
community, with AndrzejL's Game Zone: Warzone
2100 article. TuxTorch also gives us a glimpse at the
new Linux game installer in Linux, with his DJL: A
Linux Gamer's Paradise article. I take a closer look
at how you can contribute back to PCLinuxOS, in my
How Can YOU Contribute Back To PCLinuxOS?

article. Leiche reprises his ZipPlayer article from last
month, with ZipPlayer Plays Music Archives: Part
2. Hairyplotter shows us how to set up our own local
repository, with his Creating A Local PCLinuxOS
Repository article.
Of course, back this month are the regular columns
by ms_meme, Forum Foibles: Friendship and
ms_meme's Nook: If My Friends Could See Me
Now. Georgetoon also gives us another installment
of Double Take & Mark's Quick Gimp Tip. Smileeb
details how he made a slide show for his niece's
recent wedding, with his How I Finally Made My
Slide Show article. Wamukota describes how to set
up PCLinuxOS 2010 to use USB speakers, in his
Configuring PCLinuxOS 2010 KDE 4 To Use
External USB Speakers article. I start a periodic
examination of Firefox addons, with my Firefox
Addons: Personas Make It Personal article.
Blndsyd continues his series, Gimp From A
Beginner's Perspective: Part 2. Darrel Johnston
starts a new series that takes a look at alternative
free, open source operating systems with his
Alternative OS: ReactOS article. Of course,
Screenshot Showcase is back, with 11 new images
collected from the Monthly Screenshots thread of
the forum.
This month's magazine cover is by Timeth, and
literally puts the spotlight on Phoenix, the
PCLinuxOS Xfce remaster. We round out the articles
in the June, 2010 issue of the magazine with a
testimonial from Terrick Wright, in the Testimonial:
A PCLinuxOS Journey article.
So until next month, I wish each and every one of
you peace, happiness and tranquility.
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How
How Can
Can YOU
YOU Contribute
Contribute To
To PCLinuxOS?
PCLinuxOS?
by Paul Arnote (parnote)
A couple of months ago, we talked about community,
and specifically, the PCLinuxOS Community. Last
month, we talked about how to be a good citizen in
the PCLinuxOS Forum. Most any PCLinuxOS user
can vouch for the value of the incredibly stable
operating system that Texstar and the Packaging
Crew provide for us. None of us are forced to give
anything back. Not even a thank you. No money.
Nothing. But, as a good community citizen, there are
ways you can contribute back to PCLinuxOS. Let's
take a look at some of those ways.
Donate and receive PASS Server account as a
thank you from Texstar. Like I said before, no one
forces you to pay anything for PCLinuxOS. Yet,
there are operating costs involved. Those costs
include payment for the servers that run the
PCLinuxOS web site. Surely, PCLinuxOS is a free
Linux operating system. And that is what attracts
many of us to it. By making an annual donation of
$25 (U.S.) or more, you will get access to the PASS
server for one year. In case you aren't familiar with it,
the PASS server is where the stable packages
appear first (often about three days earlier), before
being posted to the public access servers. With a
PASS Server account, you get access to new
packages before the rest of the community.
When you think about the value of what you've
received from using PCLinuxOS, that's a pretty
cheap price. Another way of thinking about it is how
much would you spend for a commercial operating
system, were a free alternative like PCLinuxOS not
be available? For the price of only five or six Grande
Latte's from Starbucks, you can help defer the costs

involved in running PCLinuxOS, and get access to
the PASS server in return.
Volunteer your services. All of us have areas that
we excel in. Some may do exceptionally well at
creating graphics. Some may write well. Yet others
may be really good at
explaining things. Whatever
your area of excellence is,
you can volunteer those
services for the community.
For me, I volunteer my time
to help create The NEW
PCLinuxOS Magazine. It doesn't matter how
inconsequential you may think your contribution is. It
is valued. Sproggy, Archie and Timeth all excel at
graphics. Coffeetime excels at helping users sort out
their wireless issues. MBantz is the resident MythTV
expert. AndrzejL excels at making videos that help
showcase PCLinuxOS. There are many others who
excel in their area of expertise. Even our forum
moderators and administrators volunteer their time
to help insure that everything runs well and in an
orderly fashion, lest chaos should reign.
Become an
evangelist. Tell other
computer users of the
wonderful thing you've
found with PCLinuxOS.
Talk up the fantastic
job it does at
recognizing your
computer's hardware,
old and new. Brag on
how stable it is. Wax poetic on how you can browse
the internet, without fear of picking up a virus,

malware or spyware ... all without running an anti
virus suite or an antispyware package. Reveal how
secure your computer is running PCLinuxOS. Chat
about all the programs you can run, that are all
available for the same price as PCLinuxOS: free!
Give out free copies of the Live CD. I don't know
about you, but I give out copies of the PCLinuxOS
Live CD (or one of its excellent remasters) like I'm
giving out free cotton candy at the state fair. I'm
rarely without a copy (or more) to give out to those
who express more than a passing curiosity about
PCLinuxOS. Often times, these are computer users
who have older hardware who feel left behind with
the "advances" of commercial operating systems,
who cannot afford to go out and buy new hardware
every time a new version of the commercial
operating system comes out. By doing this, I've
converted the following to PCLinuxOS (either KDE,
or one of the remasters): a fatherinlaw, two
brothers, three coworkers, my shift supervisor, my
wife, a nephew, and two nieces. Those are just the
ones that I know about. By giving out free copies of
the Live CD, and explaining that they can try it out
without making any changes to their computer's hard
drive, you are likely to get them to at least give it a
try. And, the cost for you is minimal (at least in the
U.S.), with blank CDRs costing well under 25 cents
each.
Attend local LUG
meetings. Most people
have local Linux User
Groups in their area.
Attend their meetings.
Volunteer to give a talk
about PCLinuxOS. Hand
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out free copies of the PCLinuxOS Live CD.
Evangelize at those meetings. Show off your laptop
running PCLinuxOS.
Post product reviews for your computer
equipment. Believe it or not, people DO read the
product reviews at such online retailers as
Newegg.com and Amazon.com. When I am looking
to purchase a new piece of computer equipment, I
frequent the online retailers (there's little that can
beat shopping from the comfort of my sofa, without
any pressure or misinformation from illinformed
sales people). Once on the online retailer's site, I
look through the product reviews. Specifically, I look
for reports that the hardware works well with Linux.
I'm doubly thrilled when I see a report that a piece of
hardware works well with PCLinuxOS.
I recently purchased a new laptop from
Newegg.com. After it was delivered, one of the first
things I did was to run some of my PCLinuxOS Live
CDs on the new computer. I then went back and
entered a product review for that laptop. As a result
of my product review, it weighed heavily in the
decision of another PCLinuxOS community member
to purchase the same laptop for his use.
An added benefit is that it helps get the name of
PCLinuxOS out there for others to see. The more
they see it, the more likely they are to remember it
when they go distro hopping. So, every PCLinuxOS
user should take the time to go back and enter a
product review for every piece of computer hardware
they purchase and use with PCLinuxOS.

Learn how to package. Believe it or not, you can
learn how to package RPMs for PCLinuxOS. If you
are interested, you can head on over to the
Packager's Section of the PCLinuxOS Forum.
There, you will find instructions on how to get started
with packaging, and also be able to pick the brains
of those who are already helping create packages
for PCLinuxOS. It might also be advantageous to
check out the "Santa's Little Helpers" archived
thread over at the community projects forum, at
MyPCLinuxOS.com (link takes you straight to the
archived thread).

iceberg when it comes to ways you can contribute
back to PCLinuxOS. If you have other ideas, I'd love
to hear them. If I get enough suggestions (half
dozen or more), I'll publish them in a follow up article
in the magazine.

Help other users solve their problems. Of course,
PCLinuxOS has some fairly active forums. Jump on
in there and help other
users solve their problems
and dilemmas. By doing so,
you ARE giving back to the
community. You are
reinforcing your Linux
knowledge. And you may
even learn something new in the process of helping
others, further expanding your knowledge. Most
Linux users have their own special area of
"specialty" that they can help other users with. Share
yours.
Summary
As you can see, there are several ways you can
contribute back to PCLinuxOS. Maybe you've
already thought of these. And maybe I've brought up
some ways you haven't considered. I'm sure you can
come up with some other, equally productive ways
that you can give back to PCLinuxOS. The
suggestions I offer are, I'm sure, only the tip of the

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
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Xfce
Xfce 4.6.1:
4.6.1: An
An Overview
Overview
by Paul Arnote (parnote)

About Xfce

When you ask Linux users about their favorite
desktop environments, most users are going to say
KDE or Gnome. And while both offer fine, full
featured desktops, their "full featuredness" tends to
make them a bit heavy when it comes to RAM usage
or processor usage. So what about users who want
to run Linux on their more modest older hardware,
which may not have the processing power or RAM to
support either of the "big daddies" of the desktop?

Xfce was started in 1996 (the same year as Gnome),
and stood (at the time) for XForms Common
Environment. Since that time, Xfce has been
rewritten twice and no longer uses the XForms
toolkit. Hardly anyone at the time wanted to include
it, because it depended on the closedsource (but
free for private use) XForms toolkit. Finally, in 1999,
Olivier Fourdan started a full rewrite of Xfce, based
on the GTK+ libraries. In February 2001, Xfce 3.8.1
was uploaded to SourceForge.net. Starting with Xfce
4.4.0, Xfce was updated to the GTK+ 2.0 libraries.

This is where Linux shines, by offering alternate
desktop environments. These "other" desktop
environments are typically less hungry when it
comes to processor power or RAM, enabling them to
run with ease on older, more memorylimited
hardware.
One such desktop environment is Xfce. In the
PCLinuxOS line of offerings, Phoenix 2010
showcases the abilities of Xfce. It does so, while
remaining capable of running on older hardware with
a minimum of RAM. Xfce can easily run on a
Pentium III with only 256 MB of RAM. You can only
imagine how well it performs on newer hardware.

From the Xfce website:
"Xfce is a lightweight desktop environment for various
*NIX systems. Designed for productivity, it loads and
executes applications fast, while conserving system
resources."  Olivier Fourdan, creator of Xfce
Xfce embodies the traditional UNIX philosophy of
modularity and reusability. It consists of a number of
components that provide the full functionality one can
expect of a modern desktop environment. They are
packaged separately and you can pick among the
available packages to create the optimal personal
working environment.
Another priority of Xfce is adhereance to standards,
specifically those defined at freedesktop.org.
Xfce can be installed on several UNIX platforms. It is
known to compile on Linux, NetBSD, FreeBSD,
OpenBSD, Solaris, Cygwin and MacOS X, on x86, PPC,
Sparc, Alpha...

Built using the GTK+ 2.x libraries (the same as
Gnome), Xfce aims to provide the user a fast,
responsive desktop environment, while maintaining
an attractive appearance, and without the bloat. In
essence, it aims to be lean and mean, but give the
user the most options on a stable platform.

Having been around for over 10 years, Xfce has
matured to the point where it meets those goals. It
has its own window manager (xfwm). It has its own
file manager (Thunar, named after the Nordic god of
thunder). Xfce has a whole host of additional panel
applets to add functionality. It also has a whole host
of applications written for it, to take advantage of the
Xfce goals. These include media players, a screen
shot utility, a window compositor, a special version of
Cairo dock, a text editor, a CD/DVD burning
application, its own bitTorrent client, a weather
forecast applet, and a whole host of other specially
tailored applications.
Being written using the GTK+ 2.0 libraries, Xfce can
take advantage of virtually any other application
written using the GTK+ 2.0 libraries. This includes
applications written for Gnome. Care should be
exercised when utilizing or choosing Gnome
applications, since some Gnome applications will
pull in large amounts of the Gnome libraries, thus
conflicting with the Xfce goal to create a functional
and fast desktop for modest hardware, with minimal
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what Xfce has to offer. The PCLinuxOS Magazine
staff is planning to take a look at some of the things
you can do with Xfce. Of course, we'll be using
Phoenix 2010 as our guinea pig and role model.
Here's some of what we have planned (the list is
subject to change, and may not be allinclusive):
* Creating your own xfwm themes.
* Adding/deleting items from the Xfce menu.
* Adding extra rightclick functionality to Thunar.
* Covering the Xfce Settings Manager, indepth.
* How to set up and customize your Xfce panels.
* Overview of Xfce panel applets.
* Taking a closer look at some of the Xfce specific
programs.
After all, Linux is about choice, and Xfce is just one
of the many choices that PCLinuxOS users have
been given.

Visit
Visit Us
Us On
On IRC
IRC

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
My desktop, as it appeared on my installation of Phoenix 2010 when this article was written.
software bloat. Yet other Gnome applications have
virtually no dependencies on Gnome libraries,
making them essentially GTK+ 2.0 applications,
despite their naming that favors the Gnome desktop.

Taking a CloseUp View

So why am I doing an overview of Xfce? Over the
next few months, we'll be taking a closer view at

• Go to freenode.net
• Type "/join #pclinuxosmag"
(without the quotes)
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Configuring PCLinuxOS 2010 KDE 4
For External USB Speakers

by Alain Baudrez (Wamukota)

If you are like me, you like listening to music while
working at the computer. Most desktops have a nice
set of external good quality speakers attached
because you like good quality. If you have a laptop
that audio quality is sometimes a farfetched dream.
In come the external USB speakers set. You find a
nice set, buy one, come home, plug it in, the control
led lights up and … nothing. Sound still comes
through the laptop's speakers, though. Does that
mean that the USB speaker set is not recognized?
Maybe, but mostly it is just a case of telling
PCLinuxOS to get its priorities right.

Modify the system settings:

* Open the 'Configure Your Desktop' application
* Select the option 'Computer Administration'
* Activate the 'Multimedia' option
* Select the Device Preference 'Audio Output' 
'Music'

Change the priority

It is just a matter of sliding the internal card below
the USB speakers (click on it with the mouse and
drag it to the second position), and now your
external speakers will be used to output audio from
your audio applications.

You'll be presented with a similar interface (bottom).
As you see, on my box, both the internal (ATI) and
external (USB) audio devices are recognized, with
the internal one being the one with the highest
priority.

Do the same for the other Output devices. (Video,
Communication, …)
Configure KMix
Rightclick on the KMix icon in the systray, and
configure the USB device.
Don't forget to set the 'Master Channel' to your USB
device if you want to control the audio level using
KMix.
Disconnected USB speakers
If you disconnect the external speakers, this is
reflected in the System Settings, as the USB entry is
grayed out.

9

Configuring PCLinuxOS KDE 4 For USB External Speakers

In that case, the second device – the internal audio
card – will be automatically selected. Upon logging
in, a temporary warning message appears on top of
your screen or through KNotify and you are back in
the 'old' PCspeaker output.
The next time you plug in the USB speakers, they
will be used.

Nice to know
Although you now have the correct settings, some
applications might still output their audio through the
PC speakers. In that case, it is just a matter of
modifying the program's audio preferences and
selecting the USB speakers as main audio output
device.

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
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by Mark Szorady

Double Take

Double
Double Take
Take &
& Mark's
Mark's Quick
Quick Gimp
Gimp Tip
Tip

Find at least seven differences between cartoons.

Mark's Quick Gimp Tip

The Force is with The Gimp! Thanks to
Gimp's creative community and its ability
to add plugins, a Star Wars lightsaber
effect is easily created with a single
mouse click! First, download the
lightsaber plugin from Gimp's plugin
registry at
http://registry.gimp.org/node/21369.
Drop the script into /.gimp2.6/scripts.
Next, open Gimp and open an image.
Create a new layer with transparent
background on top of the original image.
Make sure this new layer has an alpha

channel. Now, simply
draw a white line. It's
helpful if you already have
a reference in the photo
such as a sword blade,
pole, stick or other prop to draw over.
Select Filters>RED STORM FX>LXSE
v1.0. In the new dialog box, select your
core size, glow size, glow color, etc. Click
OK and the plugin does the rest! You
can see an example (at right) of how well
the plugin works. That's me using a
double lightsaber to cut my birthday
cake! Again, the plugin did all the work!

After
creating a
new layer
and
drawing
the white
lines, The
effect was
achieved
with one
mouse
click in
less than
ten
seconds!

Mark Szorady is a nationally syndicated cartoonist. His work is distributed by georgetoon.com. Email Mark at georgetoon@gmail.com.
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Xfce
Xfce 4.6.1:
4.6.1: Xfce
Xfce Settings
Settings Manager
Manager -- Part
Part 1
1
by Paul Arnote (parnote)

accuracy for those who may not have as much
dexterity, and prevents multiple occurrences of a
letter if the key experiences a "bouncing" touch.

Despite being one of the lighter weight desktop
environments, Xfce boasts a fairly comprehensive
settings manager, where you can easily tailor the
behavior of Xfce and its appearance.

Under the Mouse tab, the user can choose to "Use
mouse emulation." This is helpful for someone who
lacks the dexterity to use a traditional computer
mouse, but can operate the keyboard and use keys
to move the mouse cursor around the screen.
The default setting in Phoenix 2010 is to have all
accessibility options turned off.

Starting this month, and concluding two months from
now, we'll take a three part look at the Xfce Settings
Manager. Each month, we'll take a look at six of the
categories in the settings manager for controlling
Xfce. Notice that there are usually 19 categories, but
we'll only cover 18, since one of the icons simply
launches another instance of the Xfce Settings
Manager.

traditional manner. So by using sticky keys, it
prevents the user from having to press two keys
together (such as Shift + G or Ctrl + C).

Appearance

The user can also choose to "Use slow keys." This
allows much greater time between key presses. The
"Use bounce keys" setting helps improve keyboard

Accessibility
The first tab in the Accessibility section of the Xfce
Settings Manager, Keyboard, allows us to choose if
we want to "Use sticky keys." Sticky keys are useful
for those users who may have a disability that
prevents them from using a keyboard in the

Under Appearance in the Xfce Settings Manager,
you can make settings related to Xfce's appearance
on your computer. The first tab, Style, allows you to
select the xfwm (window manager) style you want to
apply to the decorations of the windows displayed
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on your screen. We'll talk more about xfwm themes
later, in another article. The default setting in
Phoenix 2010 is OxygenMolecule.

The third tab under Appearance, Fonts, allows you
to select which font to use when Xfce displays the
text of the window title bars, used for the text
displayed under the desktop icons, or the text
displayed on the task list in the panel. The default
font in Phoenix 2010 is Sans, 9 point. Under the
rendering section, you can enable antialiasing of
the fonts displayed on your system (the default), or
turn it off. You can also turn on font hinting and the
subpixel order to use to display your fonts. The
default in Phoenix 2010 is to have font antialiasing
enabled, with font hinting and subpixel order both
set to "None." You can also set a custom DPI setting
for the display of fonts, if you choose. By default, it is
turned off.

The second tab, Icons, allows you to select which
icon set to use. The default in Phoenix 2010 is
OxygenRefit 2.

The last tab under Appearance, Settings, allows you
to select the style for the display of toolbars. The
default is "Icons" in Phoenix 2010. You can also set
options for "Menus and Buttons," where you can
choose whether or not to show images on buttons,
show images in menus, or to enable editable
accelerators in those menus. The last section of the

Settings tab, Event Sounds, allows you to choose
whether or not event sounds are enabled (off by
default), and whether to enable input feedback
sounds (also off by default).
Calendar
Xfce sports its own calendar application, called
Orage. This calendar program it tightly integrated
into the Xfce
desktop, is
highly
configurable,
and can be set
to alert you to
appointments
and important
dates with either
a message
popup, or with a
sound
notification. It
also allows you
to specify a "to
do list" that is
linked to your
calendar. Orage
also sports a
panel plug in,
but the plug in is
not active in a default installation of Phoenix 2010.
Under the first tab (above), you can set the time
zone for the proper display of the current time. You
can also set the archive threshold in the number of
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months. By default, this is set to "0," or no archiving.
You can also set the file name of the sound file you
might want to play when an event occurs.

a date in Orage. All the settings in the above graphic
are the default settings in Phoenix 2010.
The second tab, Display, allows you to specify how
to display the Orage Calendar main window. The list
of options are fairly obvious as to what each does.
The third tab, Extra Setups, allows you to make
further customizations to the calendar display. You
can choose whether today's date is always selected
when the calendar is opened. You can also select
the dynamic icon size for Orage to use. The last
setting allows you to select whether the Days view or
the Event list is displayed when you double click on

Desktop
Under Xfce Settings Manager's Desktop settings,
you can further fine tune the appearance of your
Xfce desktop. Under the first tab, Background, you
can select the wallpaper to display. Under Phoenix
2010, the default wallpaper is simply called,
"Default.png."
You can also choose to specify images in an image
list. Create a new image list by selecting the third
button from the left, under the thumbnail display

section of the window. Give the image list a file
name (I used images.list) and store it in a location
you choose (I chose to store the list in the same
directory where I store all of my wallpaper files).
Then, start selecting images to fill up that list. As you
do, a thumbnail of the images you select and add to
your list will start appearing in the thumbnail display
section of the window. Now, each time you start
Xfce, a random image from your image list will grace
your desktop.
If simple colors are more your style for your desktop,
you can also select to not use any image on your
desktop. You can instead choose to use either a
solid color, a horizontal gradient, a vertical gradient,
or select transparency. You set the background
colors below the drop down selection box where you
choose the type of color display.
If you want to add one of your own wallpaper files to
the list of files to choose from in the thumbnail
selection window, simply click on the green "+"
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button, and select the file you want to add. Similarly,
you can delete images from the thumbnail selection
window by clicking on the red "X" button.
At the bottom of the screen, you can adjust the
brightness and saturation of the image that's
displayed on the desktop.

The second tab of the Desktop settings window
allows you to select how menus are displayed.
Looking through the settings, I think you'll agree that
the choices are self explanatory.
The third tab of the Desktop settings window, Icons,
allows you to specify how icons are displayed on
your Xfce desktop.
Display

The Display setting does pretty much what you
might expect it to do: it allows you to set up the
display of Xfce on your monitor. You can choose the
resolution, the refresh rate and the orientation of the
screen rotation. If you have more than one display

adapter on your system, you will also see it listed on
the left side of the window.
File Manager Settings
When you select File Manager Settings, you can
select some of the behavior of Thunar, the default
file manager in
Xfce. Under
the first tab,
you can select
items relating
to the default
view Thunar
will provide.
You can view
new folders
using the
default value of
"Last Active
View," which
means that it
will display
your new
folders exactly
how you have your current view portal set up, or you
can choose "Icon View," "Compact View," or
"Detailed View." Right below that, you can select
whether or not you want folders to appear before
files in a directory listing, and whether or not to
display thumbnails.
Under "Icon View," you can select whether the text
appears below the icon (the default setting), or if it
appears next to the icon, to the side.
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You can also select how Thunar displays the date of
your files. The default value is "Today."

Under the second tab, "Side Pane," you can select
how you want icons to be displayed in the Shortcuts
Pane, and in the Tree Pane views.
The "Behavior" tab allows you to select whether
Thunar opens files with a single or double click of
the mouse.

With the "Advanced" tab, you can specify how
Folder Permissions are handled, and whether or not
volume management is enabled. Typically, on a
home installation, you will want to have volume
management enabled, so that Xfce will be able to
see and access USB drives (flash or otherwise), as
well as any cameras you might want to connect, so
you can download the images to your computer.

Conclusion & Things To Come
As you can see, the Xfce Settings Manager has a lot
of configuration options, packed into a tight space.
We've only just begun. Next month, we'll take a look
at the next six Xfce Settings Manager applets,
starting with Keyboard settings, and ending with the
Printer settings.

17

Forum
Forum Foibles:
Foibles: Friendship
Friendship

hould
unity here s
m
m
o
c
ly
d
S et a
The frien
h t a t h o me .
g
ri
l
e
fe
u
o
Enjoy!
m a ke y
shoes off.
r
u
o
y
k
ic
K
spell.

Lots of smart, interestin
g, friendly,
funny people here!!!!
(and some
who are also a little cr
azy!!!!)

Loving my new found friend in PC
Linux OS 2009.2.

Thanks for the friendly help fellas.

Glad you feel at home
by now.
Friendly support is th
e best and
you can find it here.

Friendliest, most helpf
ul forum I
have ever been with. Ve
ry grateful
to all the PCLinuxOS
team.
ed with
And the forums are fill
y go out of
friendly folks who reall
t your
their way to help you ge
system running tiptop!

Welcome home, Friend!

There's a rumor going 'round
I want to put to rest
That our forum's the friendliest
besides being the best
I wanted to ask the mods
as I started on my quest
But decided to search ...
instead of being a pest
I typed in 'friend'
and boy was I impressed
A hundred zillion hits
more than I would'a guessed
"Friend this" "Friend that"
posted with great zest
Is the rumor true? Yep!
We are really blessed

ke
ou will ma
y
,
rn
a
le
u
l
You wil
laugh if yo
l
il
w
u
o
y
nd
friends a
rum.
use this fo

And don't be
afraid to ask a
nything
you need here
. Everyone he
re is
very friendly
and helpful,

We're a fun loving bunch. One thing
about friends who have fun together,
we always forgive each other, in the
morning, no matter what. So, come
join in the fun!
Welcome to o
ur friendly lit
tle corner of th
penguin unive
e
rse. You don't
have to be
crazy to be he
re, but it help
s.

The PCLOS community is still the
most helpful and friendly forum in
the Linux world.

e to all
d gratitud
n
a
s
k
is
n
a
th
to make th
o
My ma n y
d
s
in
m
d
d!
and a
o u r mo d s
rum aroun
fo
x
u
in
L
liest
the friend

18

Forum Foibles: Friendship

n d s,
new frie
r
u
o
ll
a
nd
To
b o a rd s a
e
th
to
welcome
unity.
the comm

I really want to keep this distro
because of the great and
friendly support I've received.

I'm sure
you'll en
joy your
and as a
stay here
lways W
elcome n
ew frien
d.

This forum ....Friendly and Helpful
exactly what it says on the can.


d, ease
e
e
p
s
I
h it's
me wit
dly help
n
ld
e
i
o
r
s
f
xO S
t t he
l.
PCLinu d stability, bu
t he dea
d
n
le
a
a
,
e
e
ms s
o f u s
h e f o ru
t
n
o
d
f oun
PCLOS forum 'tis the friendliest.

Everyo
ne her
e is he
fr i e n d
lpf
ly, so
d
on't he ul and
have a
s
it
p ro b l e
m or w ate if you
ant t o
chat!

Welcome to the friendly and most
supportive world of PCLinuxOS. So make
yourself comfortable and enjoy.

What matters what friends look like
What matters where friends live

What matters what friends dress like
It only matters what friends give
I cannot know the future

Beyond me it transcends
But I do know for certain
I am glad for my

PCLinuxOS FRIENDS
ms_meme

And welcome to the friendliest most New
Friend friendly
Linux user forum in the world

Thanks
all for th
ef
I shall d
o my be riendly replies
.
st to be
worthy.
Thank you my dear friend
& fellow countryman !!

rent walks
Friends from diffe
es.
life open one's ey

of

Ask whatever
you need peo
ple
here are very
friendly.

e
r the sam
fo
g
in
k
o
lo
and
We're all
problem,
d
e
x
fi
a
,
.
outcome
nity friend
u
m
m
o
c
y
a happ

Again thanks for the friendly welcome.
You'll find the community here is very
friendly and helpful.

I predic
t t hat y
ou'll fin
helpful
d fr i e n
assista
dly,
nce fro
h e re o n
Friendly support is the best and you can find it here.
m folks
t he P C
right
LinuxO
S
f
o
Lots of friendly folks around here ready to lend a helpful hand.
ru m.

19

Screenshot Showcase
Your Community Projects Forum

Want
Want To
To Help?
Help?

Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
Uploaded by dotunix, May 16, 2010, running KDE 4

You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.

20

Command
Command Line
Line Interface
Interface Intro:
Intro: Part
Part 9
9
by Peter Kelly (critter)
Almost everything that you do on the command line
involves moving, changing, comparing or deleting
text data. This data may reside in a file on a disk
drive or be generated as the output from a previous
command in the form of a data stream.
When the UNIX operating system was first
developed at Bell Laboratories in the early 1970's,
Ken Thompson, who is generally regarded as the
chief architect of the project, was keen to implement
a system of interconnecting streams of data as an
alternative to using a series of discrete processes to
achieve the required output. Today we refer to this
system as 'pipes' and 'redirection'.
The software tools available in those dark days were
rather primitive, but have mostly survived and
evolved into what we use today. The program ed has
survived mostly unchanged in its usage since those
times (which probably accounts for its lack of use
today). ed is a line editor, unlike text editors such as
vi(m). A line editor reads in a file and works on one
line at a time, not on the whole file. You make
changes to the line and then move to another line.
Just as the program was simple, and so were the
commands. You used p to print the line to the
terminal so that you can actually see what you are
editing (this is not done automatically), d to delete
the line, s to substitute some text for some other
text, but only in that line. To edit a large text file
interactively, by hand, this is far too restrictive. So
the text editors that we more commonly use today
were developed.

With the introduction of pipes for streams of data
through this method of editing line by line, non
interactively is ideal and so a new tool was
introduced known as a stream editor. This reads in
data and applies a series of commands to the data
as it flows through. These commands, deletions,
substitutions etc, could be supplied on the command
line, or read in from a file or script. If the input data is
from a file, then that file is not changed. Only the
data in the output stream is affected, and this can be
saved as a new file or further processed along the
'pipeline'.
As a model for this new tool, the ed editor was
chosen and named sed  stream editor, which you
may have heard of.

SED

The sed utility retains a lot of the simplicity of
commands it inherited from ed, but it adds a lot more
functionality. Its command line or script can be a
bewildering gibberish text when you first encounter
it.
sed n e 's/M/ MegaBytes/;s/.\{12\}\(.\..
MegaBytes\) \([09]\{4\}\)\([09][09]\)\([09][09]\)
..:.. \(.*$\)/\4\/\3\/\2 \1 \5/p' seddemo
If we break down this gibberish into manageable
phrases, then it becomes more comprehensible. It
really does, trust me.
Now before you throw your hands in the air and say
"This is not for me!" let me say that it is very unlikely
that you would ever need to construct such a
complicated command.

Here's something a lot simpler and is actually useful.
Many Linux users also use MS Windows, but if you
try to read a Linux created text file in Windows, then
you find that the line breaks don't work and extend to
the full width allowed by the editor, probably
notepad. This is because Linux terminates its lines
with a newline character \n, while DOS and
Windows need a newline and a carriage return pair
\n\r (just like the old typewriters, where you move
the paper up a line and push the carriage back to
the beginning of the line). A newline on its own is not
recognized as a line termination. Sed makes light
work of this.
sed 's/$/\r/' linuxfile > dosfile makes Linux files
DOSreadable.
sed 's/\r//' /dosfile > linuxfile converts them back,
although this usually isn't necessary as Linux will
disregard the extra carriage returns.
It would be a trivial matter to put these two files in a
script and create a couple of aliases to them,
perhaps l2d & d2l.
The syntax of sed is very simple:
sed {options} {commands} {file}
options
The most useful options available for GNU sed,
which is the version that Linux users will most likely
find that they have installed, are:
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e

n

is required when you are specifying
commands on the command line and tells
the application that what follows should be
treated as a command to be applied to the
current line. The option can be repeated on
the command line to apply multiple
commands to the input data.

piped in to the command, e.g. cat file | sed
command or ls l | sed command.

silent mode, don't automatically print the
lines to stdout.

total 31M

f script add the contents of the named script to the
commands to be executed
r

use the extended set of regular
expressions (like egrep)

posix disable gnu extensions. This makes scripts
portable to systems that have the standard
unixlike version of sed
help

covers all the options for the version that
you are using.

commands
These define what you do to the data as the stream
passes through, and I will describe the use of the
most important ones in the body of this text.
file
This is the input data stream, and if the file name is
supplied on the command line, it is treated as stdin.
That is, sed command file and sed command <
file mean the same thing. The input may also be

To get started, find or create a file to play around
with. I have used a short listing of my /boot directory,
in a file named seddemo, ls AlLGgh /boot >sed
demo, which looks like this:
rwrwr 1 440 20100402 10:59
boot.backup.sda
rwrr 1 111K 20100403 15:11
config
rwrr 1 108K 20100316 15:11
config2.6.32.10pclos2.pae
rwrr 1 111K 20100403 15:11
config2.6.33.2pclos1.pae
rwxrxrx 1 579K 20100402 10:59
gfxmenu*
drwxrxrx 2 4.0K 20100405 04:11
grub/
rw 1 6.4M 20100402 11:35
initrd2.6.32.10pclos2.pae.img
rw 1 6.4M 20100404 08:56
initrd2.6.33.2pclos1.pae.img
rw 1 6.4M 20100404 08:56
initrd.img
rwrr 1 1.5K 20100410 14:04

kernel.h

rwrr 1 1.5K 20100402 11:59
kernel.h2.6.32.10pclos2.pae
rwrr 1 1.5K 20100410 14:04
kernel.h2.6.33.2pclos1.pae
rwrr 1 249K 20061105 23:23
messagegraphic
rwrr 1 1.4M 20100403 15:11
System.map
rwrr 1 1.4M 20100316 15:11
System.map2.6.32.10pclos2.pae
rwrr 1 1.4M 20100403 15:11
System.map2.6.33.2pclos1.pae
rwrwr 1
latin1.klt

256 20100402 10:59 uk

rwrr 1 2.0M 20100403 15:11
vmlinuz
rwrr 1 2.0M 20100316 15:11
vmlinuz2.6.32.10pclos2.pae
rwrr 1 2.0M 20100403 15:11
vmlinuz2.6.33.2pclos1.pae
This file contains a mixture of lines of varying length,
and fields of differing construction. To select only
data that meets certain criteria, and to reformat
parts of it to more accurately meet my requirements,
would be very difficult without a utility like sed.
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The changes I want to make to this set of data are:
1. Remove the total count
2. Keep only regular files, no links,directories etc.
3. Remove the permissions fields
4. Remove the link counts
5. Keep only lines that contain files of 1MB or
larger
6. Change 'M' to 'MegaBytes'
7. Change the date format from yearmonthday to
day/month/year
8. Remove the time field
9. Output the date size and file name  in that
order.
Now that looks like a lot of work, but thanks to the
flexibility of sed, I can do it in one command.
To get rid of the line 'total 31M' and leave only the
lines with file details, I could issue the following
command:
sed e '/total/d' seddemo
This is the beginning of the output from this
command.

The line at the start of the listing that contained the
expression total has disappeared from the output.
So what did I do here? I issued the sed command
with the e option, which told sed to treat the next

command line argument, '/total/d', as a command to
apply to the input file seddemo.
What sed did was to read in the entire seddemo file
line by line into an area of memory known as pattern
space and examined each line to see if it could
match the regular expression total, which is
surrounded by a pair of slashes. Whenever a match
was found, sed applied the d command, which
deletes the current line from pattern space. This
results in no output from sed from the analysis of
that line. Lines that do not contain a pattern match
are unaffected and flow through the command to
stdout, which in this case is the terminal, as output
has not been redirected elsewhere.
While that simple example of sed usage is not
difficult to follow, the key phrase here is 'regular
expression,' and a good understanding of regular
expressions is required to make effective use of this
command.
We covered the basics of regular expressions when
we discussed the grep command, so perhaps a
refresher is in order.
A regular expression is a sequence of literal
characters and metacharacters. Literal characters
are treated exactly as they are written and are case
sensitive. Metacharacters have a special meaning
in regular expressions, and must be expanded to
produce the search pattern from the regular
expression. These are the basic metacharacters:
.

The dot character matches any single character

*

The asterisk matches zero or more
occurrences of the preceding character.
This is not the same behavior as the shell
wildcard character.

^

The caret is a tricky one, it has two
meanings. Outside of square brackets it
means match the pattern only when it
occurs at the beginning of the line, this is
known as an anchor mark. As the first
character inside a pair of brackets it
negates the match i.e. match anything
except what follows.

$

Another anchor mark this time meaning to
only match the pattern at the end of a line.

\« \»

More anchor marks. They match a pattern at
the beginning \« or the end \» of a word.

\

The backslash is known as the escape or
quoting character and is used to remove
the special meaning of the character that
immediately follows it.

[]

Brackets are used to hold groups, ranges
and classes of characters. Here a group
can be an individual character.

\{n\}

Match n occurrences of the preceding
character or regular expression. Note that n
may be a single number \{2\}, a range
\{2,4\} or a minimum number \{2,\} meaning
at least two occurrences.
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\( \)

Any matched text between \( and \) is
stored in a special temporary buffer. Up to
nine such sequences can be saved and
then later inserted using the commands \1 to
\9.

In the previous example, the regular expression we
used, total, contained only literal characters. But
more usually, you will build up a regular expression
from literals, metacharacters and character classes
such as [:digit::] or [:space:]. The use of meta
characters in regular expressions enables you to
very quickly match quite complicated or unknown
patterns. Some examples:
sed e '/^#'d' .bashrc would strip out any comments
from your .bashrc file as comments begin with a #.
sed e '/^$/d' .bashrc would remove any blank lines
by matching the beginning and end of the line with
nothing in between.
It is quite safe to try these out since the source file is
not altered. Only the output to the terminal is
changed.
In my test file, I have one directory, /grub, and this is
denoted by the letter d at the beginning of the line.
To remove the line, we can use sed's delete
command with a regular expression that matches
only that line.
sed e '/^d/d' seddemo matches all lines
beginning, that's the ^, with d, and applies the delete
command. The command is single quoted to prevent
shell expansion of meta characters. Recall that
single quotes are known as strong quotes, and

protect the contents from the effects of shell
expansion, which wouldn't have had any effect here,
but it is a good habit to get into.
To keep directories and remove all other lines, we
need to reverse the effect of the command, which
we can do with:
sed n e '/^d/p' seddemo
The n turns off automatic echoing of pattern space
to the terminal, and the p command, on finding a
pattern match, prints the current contents of pattern
space to stdout which, as the output has not been
redirected, is the terminal.

In the first example, I matched the pattern total to
remove the first line, but I could more easily have
specified an address.
sed e '1d' seddemo the 1 is the line number that I
want to remove. Addresses can be ranges, so sed e
'8,20d' will remove lines 8 to 20 from the output.

Alternatively we could look for lines that begin with a
hyphen, and that would also exclude anything that
wasn't a regular file.
sed n e '/^/p' seddemo
image
The directory line has been removed but so has the
total line as that also did not begin with a hyphen. In
this case it helps, but we have to be extremely
careful about what we want to include or exclude.
Similarly, we can remove all lines that do not contain
an uppercase M followed by a space to keep only
files of one MB or larger. Without the space, the total
line would be included, as that also contains an
uppercase M but no trailing space.
sed n e '/M /p' seddemo

Notice that the total line and the directory line are
still in the output, as the original data has not been
altered.
In this case, I knew the address was 1, but usually
you have to search for it. You do this by specifying a
regular expression surrounded by slashes. The
address of the line to delete in the first example was
given by matching the regular expression /total/
Substitution
Now that we have a means of keeping only those
lines that we want in our final data set, we need to
change some of that data.
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Probably the most used command for sed is s, to
substitute one regular expression for another. The
format for this is:
sed e 's/old/new/' {file}

The substitute command can also be used to good
effect to delete a part of the line. To remove the time
field, we could match two characters followed by a
colon followed by two characters and replace it with
something like this:

So that the command

sed e 's/..:..//' seddemo

sed e 's/M/ MegaBytes/' seddemo

To remove the permissions, the link count and
trailing space at the start of the line, we could match
a hyphen followed by exactly 12 characters by using
the dot, \{ & \} metacharacters.

would change all the uppercase Ms to ' MegaBytes'
(note the preceding space) in my test file. Note that
sed by default only matches the first occurrence of
the pattern on each line. If you need to match every
occurrence, which is often what you want, then you
have to add the g global command:
sed n e 's/r/R/p' seddemo would only replace the
first r with R.
sed n e 's/r/R/gp' seddemo replaces every
occurrence.
Combining two commands we can make a
substitution and output only the lines that we want to
keep.
sed n e 's/M/ MegaBytes/' e '/Mega/p' seddemo

Putting all this together makes for a pretty long
command line, so I have used the shell line
continuation character, the backslash, to make it
more legible. But remember that it is all one line, as
far as the shell is concerned.

sed e 's/.\{12\}//' seddemo
The dot matches any character, and the number
inside the escaped braces tells the command how
many matches to make. In other words, match
exactly 12 characters.
One thing to be aware of when using regular
expressions with meta characters is that they are
greedy. They will always try to match the longest
possible string.
If you try to remove the permissions with a command
like this:
sed n e 's/.*//p' seddemo

The skill in using sed is recognizing what you want
to match, and the building of a regular expression
that matches that part of the line, and only that part.
This comes with practice and an understanding of
regular expressions. Matching the file name is quite
tricky, as there seems to be no 'standard format' that
could be easily matched. So the easiest way out is
to match everything else.
sed e 's/.\{34\}//' seddemo
Here's the start of the output:

looking for a hyphen followed by some characters
followed by a hyphen, then you might be
disappointed to see that it matched strings like this
rwrr 1 111K 20100403 15:11 config2.6.33.2
and output only pclos1.pae
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No, I didn't count all 34 characters. I took a guess,
tried it and adjusted it. This trial and error method is
quite common when building regular expressions,
although not everyone admits it.
If you noticed that the total line is in the output, it is
because it doesn't begin with a hyphen and we
hadn't already removed it. The order of operation of
your commands can have a great effect on the
resultant output.
sed e 's/[09]\{4\}[09][09][09][09]//' seddemo
matches the date part of the line and removes it.
Here's how it works.
The first slash starts the search expression.
[09]\{4\} matches exactly 4 digits
 matches a literal hyphen
[09][09] matches 2 digits
 matches a literal hyphen
[09][09] matches 2 digits
The second slash ends the search expression.
When a match is found, it is replaced by whatever is
between the second and third slash. In this case,
nothing.
For example, in the second line of the test file, 2010
0402 is a match and will be removed.

Now we have most of the methods needed to
complete the task, but the command line is getting
rather clumsy.
We could write a script and put all of the commands
in there, but there is another way using the meta
characters \( and \).
Any thing that matches the regular expression that
appears between this pair is is stored and can be
recalled for later inclusion. A match from the first pair
can be recalled with \1, the second pair with \2 and
so on up to \9.

rwrwr 1 440 20100402 10:59
boot.backup.sda

Here's the final command which turns off automatic
line echoing, matches the entire line storing parts of
it and then outputs some of those stored parts in the
required order.

The first expression is a substitution replacing 'M'
with a space, followed by the word MegaBytes

sed n e 's/M/ MegaBytes/' e 's/.\{12\}\(.\..
MegaBytes\) \([09]\{4\}\)\([09][09]\)\([09][09]\)
..:.. \(.*$\)/\4\/\3\/\2 \1 \5/p' seddemo
Another way of writing this command without
repeating the e option is to separate the commands
with a semicolon
sed n e 's/M/ MegaBytes/';s/.\{12\}\(.\..
MegaBytes\) \([09]\{4\}\)\([09][09]\)\([09][09]\)
..:.. \(.*$\)/\4\/\3\/\2 \1 \5/p' seddemo
Personally, I find this harder to follow, but the choice
is yours.
This is easier to follow if I break it down. Just to
remind you, here's a typical line from the input file.

sed n e 's/M/ MegaBytes/'

e 's/.\{12\}
The second expression is also a substitution,
replacing a hyphen, followed by exactly 12
characters.
\(.\.. MegaBytes\)
Followed by a character, a dot (which has to be
escaped to retain its literal meaning), another
character, a space, and the word 'MegaBytes'. All of
the matching data is stored in \1. This is the size.
\([09]\{4\}\)
followed by exactly four digits, which are stored in \2.
This is the Year.
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\([09][09]\)

\2

followed by \2 the year

sed n f mysedfile seddemo

followed by two digits, is stored in \3, and represents
the month.

\1

followed by a space and \1  the size

As we haven't specified an address before the
opening brace, all lines will be processed by
applying both substitutions to each line, and then
printing them to the terminal.

\([09][09]\)
followed by two digits, is stored in \4, and represents
the day.
..:..
followed by a space, two characters, a colon, two
more characters and a space. This is the time, but
as we don't use it, it isn't stored.
\(.*$\)/
followed by any number of characters that end the
line, hence the dollar sign. This is the file name, and
is stored in \5. This ends the search section of the
substitution.
This is what we are going to replace the data we just
matched with:
\4

First \4  the day

\/ followed by a forward slash that has to be
escaped, or else we would terminate the substitution
command

\5/p' and finally a space and \5 the file name, the
substitution command terminating slash and the p
command to print out the substituted data.
seddemo This is the name of the file that we want
sed to process.
Easy peasy :)
Of course in real life, that is far too long a command
to enter on the command line. Normally, such a
complex operation would be written to a file and
referenced by sed with the f option.
With our commands in a file, we can easily test and
adjust until we get the required result. We can also
group multiple commands that you want to apply to
the same address, or to each line, by placing them
within braces. In the previous example we changed
M to Megabytes, but more realistically, we might
want to change M to MB and K to KB. If we create a
file named sedfile (call it what you like) with the
following text:
{

s/K/KB/
s/M/MB/
p

\3

followed by \3  the month

}

\/

followed by a slash

Then execute:

Lets try another test file. Here's a very simple html
file that lends itself nicely to reconfiguration by sed.
I've named it 2010.html. Don't worry if you don't
know any html code. You only need to know that the
things in the «» affect the look and format of the web
page. «p» starts a paragraph and «/p» ends it.
These are known as tags.
«body»

<h1»PCLinuxOS 2010
Release</h1>
<p>Texstar recently anounced
the release of the 2010 version of
this popular distribution.</p>
<h2>Now available in the
following versions</h2>
<p><li><em>KDE4</em> The base
distribution</li></p>
<p><li><em>Minime</em> Minimal
KDE4 installation</li></p>
<p><li><em>Gnome</em> Full
installation of Gnome</li></p>
<p><li><em>ZenMini</em>
Minimal Gnome distribution</li></p>
<p><li><em>LXDE</em> A
lightweight desktop</li></p>
<p><li><em>Phoenix</em> The
XFCE desktop</li></p>
<p><li><em>Enlightenment</em>
The beautiful e17 desktop</li></p>
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<p><li><em>Openbox</em> Suitable for
older hardware</li></p>
</body>

And then issue the command:

This is how it appears in Firefox:

Then any line that has the <h2> tag (that's the
address to which the group of commands between
the braces will applied) will have a row of
underscores inserted before it and appended after it.

sed f sedfile 2010.html > 2010new.html

sed has three more commands that aren't used very
much, and because of their unusual two line syntax,
are best applied from a file. They are a  append, i 
insert and c  change.
The emphasized or italic text is turned on and off by
the <em> and </em> tags. To change this to bold,
we need to replace the em with b.
To do that change only for the KDE based
distributions, we need to supply a start and end
address, and write the output to another file.
sed e '/KDE4/,/Minime/s/em>/b>/g' 2010.html
>2010b.html
The beginning address is the first match of KDE4,
and the ending address Is the first match of Minime.
Voila! all done.

Our new html test file has one subheading, which is
identified by the <h2></h2> pair. Normally, there
would be many such headings, and possibly a folder
of many html files. In such a case, the overall look of
a website can be completely changed with a small
sed script. Our little test file will suffice to show the
operation of these commands.
If I create a file with this text and name it sedfile
/<h2>/{
i\
__________________________________________
a\
__________________________________________
}

The c command works in the same manner,
changing any matching line or lines with the supplied
text. If the address supplied covers a range of lines,
then the entire block of text is replaced with a single
copy of the new text.
In addition to the commands that I have covered
here, sed has many more that would stretch us
beyond an introductory text. There are flow control
commands such as b  branch which enable scripts
to loop under certain conditions, labels to which we
can jump to perform certain operations dependent
upon the outcome of a previous one, and is usually
determined by the t  test command.
There are also a group of commands to manipulate
an area of memory known as hold space. sed reads
input lines into the area of memory known as pattern
space and some, or all, of that data can be
temporarily copied to hold space as a sort of scratch
pad. sed can't operate on the contents of hold
space. It can only add to it, read from it or swap one
with the other. The commands are: g, G, h, H, x.
They are known as get (from pattern space), hold (in
pattern space) end exchange (swap). The
uppercase versions append, and the lowercase
versions overwrite the data.
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The last command that I want to mention here is y
which, in a not very intuitive way, means transform
the characters in one string to the characters in
another string by character position. The nth
character in the first string is replaced by the nth
character in the second string. As usual, an example
shows this better.

Screenshot
Screenshot Showcase
Showcase

To force a line to lowercase so that there will be no
misunderstandings when the shell is interpreting a
script:
sed
'y/ABCDEFGHIJKLMNOPQRSTUVWXYZ/abcdefg
hijklmnopqrstuvwxyz/' myscript.sh

Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine
PCLinuxOS Magazine Web Site:
http://pclosmag.com/
PCLinuxOS Magazine Forums:
PCLinuxOS Magazine Forum:
http://pclosmag.com/forum/index.php
Main PCLinuxOS Forum:
http://www.pclinuxos.com/forum/index.php?board=34.0
MyPCLinuxOS Forum:
http://mypclinuxos.com/forum/index.php?board=157.0

Uploaded by BubbaBlues, May 10, 2010, runnning KDE 4
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Xfce
Xfce 4.6.1:
4.6.1: Customize
Customize Your
Your Xfce
Xfce Menu
Menu
by Paul Arnote (parnote)

very hopeful that the menu editor will make a return
in Xfce 4.8.

Clicking on the "PC" menu in PCLinuxOS Phoenix
2010, you get a menu that is very reminiscent of the
menu used in PCLinuxOS 2009 KDE 3.5.10, and
earlier. Here is what the default menu in Phoenix
2010 looks like:

Fortunately, it's not as difficult as you might suspect.
Also, as with many things related to Linux, there
may be more than one way to modify the Xfce
menu. Let me show you the easy way.
Adding Menu Items
There is a way to add items to the Xfce menu so that
it shows up for all users.
First, we need to create a .desktop file. Xfce adheres
to the freedesktop.org standards, just like KDE and
Gnome. Part of those standards include the
standardization of the .desktop file. These .desktop
files are typically stored in /usr/share/applications,
and from there, they are available to all users on the
computer. You can read more about the
freedesktop.org standards for .desktop files, if you
are interested.
If you were to access (as the root user) these files in
a text editor, such as Mousepad in Xfce, you might
see something quite similar to the one below that
was created for xfcescreenshooter.

When you start digging into Xfce, it may not be
readily apparent how you change your menu.
Certainly, a menu editor would make customizing
your menu a lot easier. In fact, there was one in
previous versions of Xfce. The Xfce developers are

[Desktop Entry]
Version=1.0
Name=Screenshooter
Name[bg]=Снимка на екрана
Name[ca]=Captura
Name[cs]=Snímek obrazovky
Name[da]=Skærmbillede

Name[de]=Bildschirmfoto
Name[el]=Στιγμιότυπο οθόνης
Name[en_GB]=Screenshot
Name[es]=Captura de pantalla
Name[et]=Ekraanipilt
Name[eu]=Pantailaargazkia
Name[fi]=Kuvakaappaus
Name[fr]=Capture d'écran
Name[gl]=Captura de pantalla
Name[hu]=Képernyőkép
Name[id]=Cuplikan Layar
Name[it]=Istantanea
Name[ja]=
Name[nb]=Skjermbildekopi
Name[nl]=Schermafdruk
Name[pl]=Zrzut ekranu
Name[pt]=Captura de ecrã
Name[pt_BR]= Captura de tela
Name[ro]=Captură de ecran
Name[ru]=Снимок экрана
Name[sv]=Skärmbild
Name[tr]=Ekran görüntüsü
Name[uk]=Знімок екрану
Name[ur]=ﻭﺵ ﻥﯼﺭﮎﺱ
Name[ur_PK]=ﻭﺵ ﻥﯼﺭﮎﺱ
Name[vi]=Ảnh chụp màn hình
Name[zh_CN]=
Comment=Take screenshots of the entire
screen, of the active window or of a
region
Comment[bg]=Направи снимка на целия
екран, от активния прозорец или от
района
Comment[ca]=Fes les captures de tota
la pantalla, de la finestra activa o
d'una regió
Comment[cs]=Pořizuje snímky celé
obrazovky, aktivního okna nebo zvolené
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oblasti
Comment[da]=Tag skærmbillede af hele
skærmen, af det aktive vindue eller af
et område
Comment[de]=Bildschirmfoto des ganzen
Bildschirms, des aktuellen Fensters
oder eines Bereichs erstellen
Comment[el]=Λήψη στιγμιοτύπου οθόνης
ολόκληρης της οθόνης, του ενεργού
παραθύρου ή της περιοχής
Comment[en_GB]=Take screenshots of the
entire screen, of the active window or
of a region
Comment[es]=Realiza capturas de la
pantalla completa, de la ventana
activa o de una zona
Comment[et]=Tehke ekraanipildid
tervest ekraanist, käsilolevast aknast
või alast
Comment[eu]=Panataila osoaren, aktibo
dagoen leihoaren edo panatailaren
eremu baten pantailaargazki bat egin
Comment[fi]=Kaappaa kuvia koko
näytöstä, aktiivisesta ikkunasta tai
näytön alueesta
Comment[fr]=Prendre une capture
d'écran de l'écran tout entier, de la
fenêtre active ou d'une zone
Comment[gl]=Facer capturas de pantalla
de toda a pantalla, da ventá activa ou
dunha zona
Comment[hu]=Képernyőkép készítése a
teljes képernyőről, egy ablakról vagy
területről
Comment[id]=Ambil cuplikan layar dari
seluruh layar, dari jendela yang aktif
atau dari sebuah daerah
Comment[it]=Esegui l'istantanea

dell'intero schermo, di una porzione o
della finestra attiva.
Comment[ja]=
Comment[nb]=Ta en skjermbildekopi av
hele skjermen, det aktive vinduet
eller et område av skjermen
Comment[nl]=Schermafdruk maken van het
gehele scherm, het actieve venster of
van een deelgebied
Comment[pl]=Wykonuje zrzut całego
ekranu, bieżącego okna lub wybranego
obszaru
Comment[pt]=Capturar imagens de todo o
ecrã, da janela activa ou de uma zona
Comment[pt_BR]=Obtem uma captura da
tela inteira, da janela atual ou de
uma região
Comment[ro]=Capturi ale întregului
ecran, ferestrei active sau unei
regiuni
Comment[ru]=Выполнить снимок всего
экрана, активного окна или региона
Comment[sv]=Ta skärmbilder av hela
skärmen, aktivt fönster eller ett
område
Comment[tr]=Tüm ekranın, etkin
pencerenin veya belirli bir alanın
ekran görüntüsünü alır
Comment[uk]=Отримати знімки всього
екрану, активного вікна або окремої
області
Comment[ur]=ﻥﯼﺭﮎﺱ ﯼﺭﻭﭖ، ﺍﯼ ﻭ ﻥﻭ ﻝﺍﻉﻑ
ﻕﺍﻝﻉ ﺹﻭﺹﺥﻡ
ﯼﺭﺍﺕﺍ ﺭﯼﻭﺹﺕ ﯼﮎ
Comment[ur_PK]=ﻥﯼﺭﮎﺱ ﯼﺭﻭﭖ، ﻭ ﻥﻭ ﻝﺍﻉﻑ
ﻕﺍﻝﻉ ﺹﻭﺹﺥﻡ ﺍﯼ
ﯼﺭﺍﺕﺍ ﺭﯼﻭﺹﺕ ﯼﮎ
Comment[vi]=Chụp toàn bộ màn hình, hay

cửa sổ đang kích hoạt hay một vùng màn
hình
Comment[zh_CN]=
Icon=appletsscreenshooter
Exec=xfce4screenshooter
Type=Application
StartupNotify=true
Terminal=false
Categories=GTK;Utility;X
MandrivaLinuxMultimediaGraphics

These .desktop files are typically created when you
install a package from Synaptic, and the above is a
typical example of one such .desktop file. You can
also create a simpler, more abbreviated version,
which is handy when you don't need all the language
translations for the Comment portion of the file. A
minimal .desktop file might look something similar to
Leiche's SystemInfo program, as seen below:
[Desktop Entry]
Name=systeminfo
Type=Application
Comment=Show System Infos
Terminal=false
Exec=systeminfo %U
Icon=systeminfo.png
Categories=Infos;System;Monitor;
GenericName=Systeminfos
Encoding=UTF8
In the minimalistic .desktop file above, it contains
mostly only the required information. The "Name"
parameter specifies the name of the program, as it
will appear in the menu and is a required entry.
There is also a "GenericName" entry, albeit an
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optional one. It is considered good form to include it.
For example, "Name" could have said "Firefox,"
while "GenericName" could have stated "Web
Browser."
"Type" specifies that the file we are making a menu
entry to is an application, and is another required
entry. The "Comment" field holds the information that
is revealed in a small pop up window when you
hover your mouse over the menu entry.
You will also notice that the "Terminal" entry is set to
false. If we wanted the application to open in a
terminal session, we can change this parameter to
"true." While this entry is not required, it is
considered good form to include it. It also makes it
possible to include menu entries for any favorite
command line utility that you may like to run.
The "Exec" parameter is a required one. This is the
command to execute to launch the item. Since our
item is an application, it's command we would use to
launch the program. We can specify the graphic file
to use as the entry's icon, with the "Icon" parameter.
The "Categories" item tells us where to place the
item in the menu heirarchy. Finally, the "Encoding"
parameter specifies which character set is used to
encode the .desktop file, so the system knows how
to read or interpret it. It is an optional setting, but
again, considered good form to include it. It is also
recommended that it defaults to UTF8 character
encoding.
One setting we don't see in the SystemInfo .desktop
file is the "URL" parameter. It is a required entry if
the "Type" entry is link. In that case, we specify the

URL (either a fully qualified Internet link, or a link to
a local file). This means that, if you want to, you can
create a .desktop file for one of your favorite Internet
sites (possibly the PCLinuxOS Forum), or a file you
frequently access on your computer.

exodesktopitemedit createnew
/usr/share/applications

Of course, you can create the .desktop file by hand,
in a text editor. Fortunately, there is a GUI that helps
create them.

Now enter the requested information. On the "Name"
line, enter what you want to display in your menu
item. On the second line, Comment, enter the
information you want displayed when you hover your
mouse over the menu item. The "Command" line is,
as you might guess, the command you want to
execute when you select the menu item. Here, I'm
playing a wave sound file, r2d21.wav, when the
menu item is selected. Obviously, you may want
your menu selection to do something more
significant than listen to r2d2 beep about your
computer. Next, click your mouse on the "No Icon"
button, and choose an icon you want to use to
represent your menu entry. Click on "Create" to have
your new .desktop file created in
/usr/share/applications.

GUI Creation of .desktop Files
First, open a terminal session, and change to the
root user. Once you have root privileges, enter the
following on the command line:

This will display a window, like in shown in the
previous column.

(Tip: if you plan on doing much of this, you may want
to make a menu entry using the command above, to
make it easier create additional menu entries. If you
do, you need to change your command line to read
gksu l 'exodesktopitemedit 
createnew /usr/share/applications' and
when launched, it will properly ask for the root
password. You must have root privileges in order to
save the new .desktop file to
/usr/share/applications.)
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We're Almost There ...

Removing Menu Items

There's only one more thing we have to do, and that
is to specify where to place the menu item within the
menu hierarchy. Notice that we really haven't
messed with the menu hierarchy. That is defined
elsewhere on your system. You can take a look at it
by going to /etc/xdg/menus/applications.menu.
But whatever you do, do not change anything there,
unless you REALLY know what you are doing.
You've been warned. All we are doing here is adding
menu items within that menu hierarchy.

Lastly, if we can add menu items, we may also want
a way to remove a menu item, as well. There are
two ways to do this. First, we can simply delete the
.desktop file from /usr/share/applications. But this
method is destructive, and leaves you with no option
to get the entry back should you later change your
mind. You also lose all mime associations with that
program, which may not be a good thing.

With root privileges, go to /usr/share/applications,
and open the .desktop file you just created. Look for
the "Categories=" section. At the end of whatever is
on that line, add the following:
XMandrivaLinuxMultimediaSound
This tells Xfce to place a menu item in the Sound
submenu of the Multimedia menu (we are still
presuming that we are playing the sound file from
our example earlier). If you followed the tip above
about how to put the GUI for creating .desktop files,
you may want to put a menu item under System >
Configuration. In that case, you would append the
"Categories=" line with the following:
XMandrivaLinuxSystemConfiguration
This will insert a menu item under System >
Configuration with the name you specified and the
icon specified. Trust me, it's a lot easier than it
sounds.

Fortunately, there's a much easier and less
destructive way to remove a menu item. Simply add
the following line to the .desktop file you want to
remove from the menu:
NoDisplay=true
The .desktop file is preserved, as are all the mime
associations with that program. And, should you
change your mind and want the program
represented by your .desktop file to appear in your
menu once again, all you have to do is remove that
line.
Conclusion
As you can see, it's relatively easy to add and
remove items from your Xfce menus. Certainly, it
would be a lot easier if there were a GUI menu
editor, but then the Xfce developers are aiming to
have that back in the mix in version 4.8.x of Xfce.
Still, the process is not difficult, even if it is not
readily apparent how to add or remove menu items.

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos
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Open Office:
Office: An
An Overview
Overview
by Meemaw
I love OpenOffice! I needed something I could use at
work in Windows and at home in Linux and that
could open nearly any document I received.
Just in case you aren't familiar with OpenOffice, it is
a suite of office programs that closely resemble MS
Office ("Wow, there is an office suite that is
compatible with MS Office? All my friends use that
and send me stuff all the time, but I can't afford to
buy the new version. I can't pay $150.00 or more for
an office suite." I'm sure we've heard this many
times.)

faster startup time. In PCLinuxOS, GetOpenOffice
is a little script to facilitate the installation of, adding
localizations to, and proper removal of GO
OpenOffice."
After you install it, you will want to configure it for
use. Open up OpenOffice Writer. Go to Tools >
Options and you'll see the following;

The following list shows the comparison:

This will be a series on using OpenOffice. If you
have not installed it yet, it is a simple as going to
System > Configuration > Get OpenOffice. This will
start the program which will install it to your
computer.
One of our forum experts, Pinoc, tells us "as with
many other distros, PCLinuxOS uses GOOO
instead of the standard OO. The reasons for this
choice are basically listed on the mentioned GOOO
homepage. Basically, GOOO is OpenOffice plus
some useful enhancements, one of them being a

This is the settings
window, where you
can configure the way
you want OO to work.
In the first section,
OpenOffice.org, you
can enter your User
Data (name, address,
company, phone
number and so on.)
This is handy in many
of your documents,
and even if you want
to print a sheet of return labels with your address on
them. The Memory section lets you choose how

much memory you want your computer to use to run
OO. You can keep the default if you wish. You can
also choose to enable a quickstarter icon for your
system tray. You can designate the colors you want
to use, security settings and appearance, plus much
more.
In Load/Save, you can designate the default file
format for your documents. You can
even have some MS Office
documents automatically converted
to OO format. Many of us need to
work with MS Office documents
daily, so OO.o can be configured to
save documents in the MS Office
format automatically.
In Language Settings, you can
designate OO.o to appear in your
native language (if available) and set
the aids you can use for your work
(dictionaries.)
In
OpenOffice
Writer, you
can
configure
they way you
want the
window to
look when
you open it
(whether you
see the
rulers and
scroll bars, etc), a grid if you need one, the default
font, how you want tables to appear, how you want
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the editor to mark changes made to the document (if
you have to share your changes with others) and
even mail merge settings. OpenOffice Writer/Web
has many of the same settings, but in HTML format
for the web. (Note that a writer document has to be
open for these options to show.)

In OpenOffice Calc, you can configure
your spreadsheet preferences (a
spreadsheet has to be open to see this
menu.) You can configure what you
view (scroll bars, rulers, etc), what
color you want your gridlines, and
much more. The
General section is
where you designate
your unit of measure.
The last section is
Internet, which lets
you designate your
proxy server (or let the system do
it), designate your favorite search
engine, and display documents in
your browser if you wish.

OpenOffice.org Base has settings for database
files. There is a separate Charts section, where you
define the colors to use in your charts.

If you put the Quickstarter in your
system tray, you can open just about anything with a
rightclick on the icon. You will get a popup menu
like the one below. Notice you can start any kind of
new document, open a template or open an existing
document from there.

If you go in your main menu and click on
OpenOffice.org, this screen pops up (it does also
when you close all your documents but not the
program.) Sometimes I have this open all the time.
When you get your office suite configured the way
you want it, it's time to go to work. Settings can be
changed at any time just by reopening the Options
window. Next month we'll look at OO Writer.
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ZipPlayer
ZipPlayer Plays
Plays Music
Music Archives:
Archives: Part
Part 2
2
by Daniel MeißWilhelm (Leiche)

We must first change some entries:
Type=Service
Name=Zip_Player
Encoding=UTF8
ServiceTypes=application/zip
Actions=zip_player
XKDEServiceTypes=KonqPopupMenu/Plugin
MimeType=all/allfiles;

In the May issue of The NEW PCLinuxOS Magazine,
we learn to create a script to open a zip archive to
listen to the music files inside with xmms.
Before we get started, I need to update the previous
article: I forgot to close this line SAVE=$(kdialog 
title “zipplayer“ getopenfilename “open...“. The
corrected line is SAVE=$(kdialog title “zipplayer“ 
getopenfilename “open...“).
Now we want create a servicemenu for KDE 4.
What Is A Servicemenu?

Notice: There is not a specific order for the
sequence of entries.
So, the right click menu shows:

A servicemenu is an entry on the right click menu,
and is used to help to start some apps easier, and to
perform special functions on certain files.
When you want to add a servicemenu only for you,
just save a text document in this directory:
/home/«user»/.kde4/share/kde4/services/ServiceMe
nus/. If you want the servicemenu to be available to
all users, then save the text document in the
/usr/share/kde4/services/ServiceMenus/ directory.
The document should be saved as
zip_player.desktop.
What should we put in the document?
When we open a another .desktop file, such as the
dropbox.desktop file, with Kwrite, we get:

In the first line, we find [Desktop Entry] as the
heading, and under that, we find the following:
Type=Service
ServiceTypes=KonqPopupMenu/Plugin
MimeType=all/all;
Actions=getPublicURL;copyPublicURL;
XKDESubmenu=Dropbox
XKDEStartupNotify=false
XKDEPriority=TopLevel

We do not need all entries, so we removed XKDE
Submenu=Dropbox, since we have only one entry in
our servicemenu. XKDEPriority=TopLevel is not
needed, either. The ServiceTypes have we specified
as application/zip. Also we add Encoding=UTF8. By
MimeType=all/allfiles; it will be displayed by all files
in the right click menu. And the line
Actions=zip_player, provides the name for the next
entry line.
[Desktop Action zip_player]
Name=Zip Player
GenericName=Zip_Player
Exec=zip_player
Icon=xmms.png
In the header we read Desktop Action zip_player,
the action for the Servicemenu (right click menu).
Name=Zip Player displays the name Zip Player in
our pop up service menu in KDE 4.
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GenericName=Zip_Player is not needed, and will not
displayed on the desktop.
Exec=zip_player specifies the executable program.
(It's always in /usr/bin, not in /bin, so you must give
the directory to the program as
/home/USER/documente/zip_player).
Icon=xmms.png displayed a icon in the right click
menu.
If you saved it in your home directory
.kde4/share/kde4/services/ServiceMenus/, and you
click now with the right mouse button on a
ziparchive, it's displayed as your new created
Servicemenu under Action » Zip Player. Feel free to
click it, but what does it do?
Why open the file browser?
It should open the archive with xmms, and not the
open file browser. Also we must change some lines
in our script, so let us do it. Open the script with
Kwrite:
#!/bin/bash
#
mkdir $HOME/.zplayer
SAVE=$(kdialog title “zipplayer“ 
getopenfilename “open...“
unzip $SAVE d $HOME/.zplayer && xmms
$HOME/.zplayer && rm fr $HOME/.zplayer | exit
At first (i forgot it) we add Encoding=UTF8, so will
correct set the font.

#!/bin/bash
#
Encoding=UTF8
mkdir $HOME/.zplayer
SAVE=$(kdialog title “zipplayer“ 
getopenfilename “open...“ )
unzip $SAVE d $HOME/.zplayer && xmms
$HOME/.zplayer && rm fr $HOME/.zplayer | exit
But now, we need a FileOpenParameter as function.
So, we add the following lines:
usage ()
{
echo "No File"
exit 1
}
#
if [ $# eq 0 ];
then
usage
fi
#
FileOpenParameter="$1"
#
and remove the line
SAVE=$(kdialog title “zipplayer“ 
getopenfilename “open...“ )

Our script shows now:
Encoding=UTF8
#Funktion
usage ()
{
echo "No File"
exit 1 #Beendet Script
}
#
if [ $# eq 0 ];
then
usage
fi
#
FileOpenParameter="$1"
#
if [ ! d $HOME/.zplayer ]; then
mkdir $HOME/.zplayer
fi
#Archiv entpacken in Ordner, öffnen mit xmms,
nach Beendigung Ordner löschen.
unzip "$FileOpenParameter" d
"$HOME/.zplayer" && xmms $HOME/.zplayer &&
rm fr $HOME/.zplayer | exit
#
exit 0
Save it and try again to open a zip archive with Zip
Player. It should now be working.

In the next line, we change $SAVE in
"$FileOpenParameter".
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Firefox Add-ons:
Add-ons: Personas
Personas Make
Make It
It Personal
Personal
by Paul Arnote (parnote)
Beginning this month, we're going to regularly take a look
at some of the more popular Firefox Addons – old and
new. If you have a favorite Firefox Addon (or several
favorite Firefox Addons), please write them up for the
PCLinuxOS Magazine and submit them to the magazine
staff. If they haven't been done before, we'll include your
Firefox Addon article in the PCLinuxOS Magazine. No
fighting over writing them up, please. Articles submitted
for the Firefox Addons column will need to be: a)
accompanied with graphics (we need to see what you are
talking about), b) should be at least one page in the
magazine, c) be limited to the discussion of only ONE
Addon per article, d) as indepth as possible (that doesn't
mean you have to have a print out of the script, but we
don't want you just "skimming the surface" of the Addon
either), yet broad enough to characterize the addon's
appeal, and e) be of good taste and suitable for
publication in the magazine.

everything is as I would like it. Something is always
amiss. Either the menu text is too dark, or the text
edit window has dark gray text on a black
background. I am personally happy with the default
Firefox theme that comes with the base installation
of PCLinuxOS, and I like Personas because it allows
me to dress that default theme up (hang new
curtains from time to time), without having to install a
full Firefox theme.

And yes, there are even a couple of custom themes
available for PCLinuxOS.

Currently, there are over 135,000 different Personas
available for Firefox. And variety is the name of the
game. Are you a Sponge Bob fan? Do you want to
see the logo of your favorite band? Are pictures of
the cosmos your thing? Whatever likes and tastes
you have, you are certain to find a Personas theme
to match.

One of the more recent, and more popular, Firefox
Addons to burst onto the scene lately is called
Personas. Personas allow you to customize how
Firefox is displayed on your computer, without the
overhead of a full theme. Think of it as putting up
curtains on your living room windows. Personas
dress up your current Firefox theme with new
curtains (graphics) for the background of the Firefox
window, all while leaving your current theme intact
and otherwise untouched.
Personas seem to present a happy medium
between no customization options and a full Firefox
theme, the latter of which can tend to slow Firefox to
a literal crawl, especially if they are not well done.
Also, I have yet to find a full Firefox theme where

The default Firefox theme in PCLinuxOS (top). Two Personas themes: Stealth (mid), and Firefox Pavoninus (bottom)
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You can get and use Personas without installing
anything, simply by going to the Personas web site.
Just click on the Personas theme that you want to
use, and you can choose to "wear it." But while you
are there, you can also get an enhanced Firefox
plug in, called GetPersonas Plus. This plug in inserts
a Personas menu in your Firefox "Tools" menu, and
allows you (when you're logged in) to save and
recall Personas themes from your own list of favorite
Personas.

The menu also gives you access to your recently
selected Personas, as well as New & Featured, Most
Popular, or
All. If you
want to turn
off Personas
and revert to
the "stock"
theme,
simply click
and put a
check mark
next to the
Default menu

item (second from the bottom, in the second tier of
the menu). Finally, Preferences brings up a few
additional choices for controlling Personas.
Make Your Own Custom Personas Theme
Anyone can make their own custom Personas
theme. The full directions are on the Personas web
site, and it would be a good idea to read through
them if you are inclined to try making your own
custom Personas theme.
Basically, a Personas theme consists of two parts:
the header and the footer graphics. The header
graphic should be 3000 x 200 pixels in size, and is
displayed at the top of the Firefox window, behind
your menus, navigation buttons, Bookmark Toolbar,
and tab bar. The footer graphic should be 3000 x
100 pixels in size, and is displayed at the bottom of
the Firefox window, as a background for the status
bar. You can use either JPG or PNG formats for your
header and footer files.
Simple and subtle designs work best. Busier designs
tend to compete for attention in the browser window,
and it's recommended to avoid them.
Once you've created your custom Personas theme,
it's time to test it out on your own computer. Don't
worry – if you don't get something quite right, you
won't mess anything up. Just delete your mistake,
and start over. To test it on your own computer, you
will need to open the Personas Preferences window,
and select the last item (Advanced » Show Custom
Persona in menu). Once you've done this, navigate

back to the Firefox "Tools" menu, select Personas,
then Custom, and Edit.
Once you've done that, a dialog window will open.
There, you can give your Persona theme a name,
specify the files to use for the header and footer
graphics, and select either a custom color for the
text that will be displayed over the Persona theme
graphics, or allow you to use the default text colors.
Note that your custom Persona theme will have only
been tested (at this point) on your computer and/or
platform. The mileage of others may vary if they
download your theme.
Now that you've created your own personal Persona
theme, you can also share it with the rest of the
world. Of course, this last step is optional, but
where's the joy in keeping your new creation only for
your use? Just follow the directions on the site, and
you can find fame and (not so much) fortune by
sharing your Persona theme with other Personas
users.
Personas are fun to play with, and you can change
them as often as you like, to help reflect your mood
on any given day ... or hour. No one says you have
to have only one or two. So if you like dark themes,
light themes, whimsical themes, serious themes,
musical themes, intergalactic themes, cartoonish
themes, anime themes ... you can tailor how Firefox
appears on your desktop to make your web
browsing experience an even more personal
voyage.
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GIMP from a Beginner's Perspective: Part 2
by Dan Malewski (Blndsyd)
Hi all, and welcome back to the beginners Gimp
workshop. This time around we will look at adding
some text to our picture. Let's jump right in where we
left off last time. Open your picture that we "sliced"
or "cropped". Here is mine.

From here, we can place our text onto
our image. I'll be adding the word
"Mickey" right above his head.

Basically we just point our mouse on the image and
a new "Box" will open where we place our desired
text. The great thing about the way Gimp adds text is
that we don't have to worry about adding "layers". It
is done automatically. I will explain "layers" in
another article. Just remember that "layers" are very
important.
For our grand finale, let's add some glow to our text.
The first step will be to add Alpha to Selection.
Select Layer>Transparency>Alpha to Selection.
Next, let's do Select>Grow>Grow Selection by 3
pixels. Next, we need to add a new Layer. To do this,
click the piece of paper with the green plus sign. In
future articles I will show you how and why adding
plenty of Layers will be beneficial.

Let's add some text to our new picture. Select the
"Big A" in the toolbox. From the same screen, you
can choose your font size and color. You will be able
to choose a different size once you place it on your
image as well.
After selecting that, you will have to choose which
font you want. In order to do that, select the "Aa"
next to "Font" and choose from the drop down. I am
going to choose something fun, and I picked
Bablefish.
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So add a new Layer and call it Glow. From here, go
to the Toolbox and select a nice Light Blue Color.
Click the Paint bucket and Fill the Layer. The next
thing to do is to slide that layer under the main text
layer so it looks like the arrangement in the Layer
toolbox.
Now we need to Select/None
(Ctrl Shift A). Keeping that

layer highlighted, select Filter>Blur>Gaussian Blur to
45. Right click the Glow Layer and select Duplicate
Layer. We will add the blur effect to this layer as
well, by setting Filter>Blur>Gaussian Blur to 30. In
the last step, lets Duplicate the Mickey Mouse text
Layer, then select Filter>Blur>Gaussian Blur to 15.
Here is my finished product.

Come
Join Us!

Visit.
Contribute.
Build.
The PCLinuxOS
Wiki
It Belongs To YOU!
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Alternative OS:
OS: ReactOS
ReactOS
by Darrel Johnston (djohnston)

to allow you to remove Windows® and install ReactOS
without the end user noticing the change."

To start off an examination of alternate, nonLinux,
noncommercial operating systems for the PC, I
downloaded and installed ReactOS in VirtualBox
3.1.2 OSE on PCLinuxOS 2007, fully updated
through 2009, running KDE 3.5.10. The
specifications for the test machine are: 2.6 GHz
AMD dualcore CPU, 4 GB of system RAM, and an
nVidia GeForce 8500 GT video card with 1 GB of
video RAM. My CRT is run at a resolution of
1280x1024. I like to run the VirtualBox machine at a
screen resolution of 1152x864, whenever possible.
You can download ReactOS 0.3.11REL from here:
http://www.reactos.org/en/download.html.

Please note the admonition on the download page:
"Please bear in mind that ReactOS 0.3.11 is still in
alpha stage and is not recommended for everyday
use."
With that in mind, I began this journey by installing
the OS from the downloaded iso file. Begin by
starting VirtualBox (available from the PCLinuxOS
repository). Click the "New" icon in the upper left
hand corner. Click the Next button.

Give the VB image a name. I chose ReactOS as the
name and WindowsXP as the operating system
type. After all, that is what ReactOS is shooting for.
Click Next. You will be asked to choose the base
memory for the virtual machine. 192 MB is the
recommended RAM for this type of install. Since I
have plenty, I like to give almost every install I do
512 MB of RAM. Click Next to choose the size of the
Virtual Hard Disk. Hard disk size is recommended at
10gB. I know ReactOS is not going to use all that,
but I accept the default and click Next. A new virtual
disk needs to be created, so click Next. The Hard
Disk Storage Type is selfexplanatory. I accepted the
default and clicked Next.

So, just what is ReactOS? From the ReactOS Home
page:
"ReactOS® is a free, modern operating system based on
the design of Windows® XP/2003. Written completely
from scratch, it aims to follow the WindowsNT®
architecture designed by Microsoft from the hardware
level right through to the application level. This is not a
Linux based system, and shares none of the unix
architecture.
The main goal of the ReactOS project is to provide an
operating system which is binary compatible with
Windows. This will allow your Windows applications and
drivers to run as they would on your Windows system.
Additionally, the look and feel of the Windows operating
system is used, such that people accustomed to the
familiar user interface of Windows® would find using
ReactOS straightforward. The ultimate goal of ReactOS is

Give the hard disk image a name and click Next.
NOTE: By default VBox stores created hard disk
images in the folder at ~/.VirtualBox/HardDisks. (~ is
your home directory, and .VirtualBox is a hidden
directory in your home directory.) The location for the
stored virtual hard disk can be changed to anything
you like by clicking on the folder icon, next to the
Location Name. Click Next on the next window. Click
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Finish on the Summary window. You will now be
back at the main VirtualBox window. Click the
Settings icon to open the Settings configuration
dialog.

Click on "System" in the left pane. Ordinarily, I have
no use for a floppy drive, or for it "cluttering up" the

boot sequence. I unchecked the floppy drive and
moved it down. I also turned IO APIC on. Note the
displayed warning, and click Next.

Click "Storage" in the left pane. You can delete the
floppy controller. I did. Select the empty CD device,
then click the folder icon at right. In the Actions
window, click the Add icon.
Browse to whatever directory contains the ISO file
and select it. Make sure the correct file is
highlighted, then click the Select button. I won't
cover the Audio, Network, Serial Ports and Shared
Folders, since I left them all at default settings. Back
in the main VirtualBox window, we can see the
general settings summarised. To launch the newly
created virtual machine, click the big green arrow
Start icon, or simply doubleclick the VM you want to
start.

The default for Video Memory is set at 16MB. I have
plenty of video to spare, so I changed it to 64 MB.
Click Next.

This thing boots very quickly. I missed the
bootsplash the first time around.
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format as FAT. Accept the default install location.
The setup procedure copies files (very quickly).
Install the bootloader to the harddisk. This entire
process will look very, very familiar to anyone who
has installed Microsoft Windows over the last 15
years or more. Many of the screens are virtually
identical, and for that reason, are not shown here.

Select your language, and press Enter to begin the
installation process.

Press Enter again. In the setup, I changed the
display parameters. Change the device settings to
your liking, highlight "Accept these device settings",
then press Enter. Choose unpartitioned space, and

Well, there's no floppy to remove, but I do need to
remove the CD before rebooting. In the lower right
hand corner of the virtual machine's window, we see
"Right Ctrl" displayed. That is the hot key
combination to regain control of the system's mouse,
previously captured by the VirtualBox session. Press
the CTRL key on the right side of the keyboard, and
our system mouse reappears. Click (in upper left
hand corner) on Devices, then CD/DVD Devices,
then Unmount CD/DVD Device.

Then press Enter to reboot the virtual machine, this
time from the hard drive. The startup screen

Pressing F8 shows:

Start the installation wizard:
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You will see the Acknowledgements screen, and can
see the GPL screen by pressing View GPL button.
Next, you will go through two more setup screens.
When I got to the Locale settings screen, I pressed
the top Customize button. This locked up the
installation routine, and ReactOS would no longer
respond. So, I pressed the RightCTRL button,
clicked the close button on the VM session, and
chose "Power off the machine."

Hmmm. Installation failed. Next, the installer found a
system device, then an ethernet controller. Driver
installation for those devices failed as well. Well, to
see what is going on with the devices, rightclick My
Computer and select Properties.

Click the Hardware tab in the Properties window.

After booting again, I was taken through the final
setup procedure as before. I left the locale options
alone and continued. Set your date and time
accordingly. Once I arrived at the desktop, a nice
ReactOS wallpaper appeared, but it was sized for
800x600 display. The Device installation wizard
began and showed my audio device.
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Then click the Device Manager button, (just like
WindowsXP). Device Manager doesn't show any
semaphores (red or yellow symbols denoting a
hardware issue). It simply lists the devices found.

ReactOS has autoplay turned on, so the VB
additions CD shows up in a new file Explorer
window. Doubleclick the VBOXADDITIONS icon,
then doubleclick the VBoxWindowsAdditions
x86.exe icon. The guest additions installation will
launch. Agree to the license and follow the prompts.
Finally, select "Reboot now" in the last window and
let the machine reboot.
Well, this didn't look good, but it is often an after
effect of installing guest additions. For some odd
reason, the guest OS will revert to the lowest
commondenominator on screen resolution. From
past experience, I knew this was an easy fix, and
wasn't necessarily the fault of the guest OS.

Well, opening a command prompt and looking at the
environment set shows this is pretty standard
Windows fare. NOTE: Using the same "set"
command on a *nix box will return much, much more
information than is shown at the DOS prompt.

No matter what I did in the advanced display
settings, such as "Apply color changes without
restart", the settings just would not stick. I rebooted.

OK, maybe the VirtualBox additions will rectify these
driver issues. Click RightCTRL, Click on Devices,
then select Install Guest Additions.

Rightclick the screen, select Properties, and change
the properties from 256 colors @ 800x600 to 24bit
truecolor @ 1152x864.
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OK, now we have a decentlooking desktop, albeit
without a wallpaper. I played for a while with putting
the wallpaper back in "stretched" mode, but
whenever I tried out a screensaver, the wallpaper
would just disappear.

the contents, you will have a folder containing an
.ovf and a .vmdk file. To import into VirtualBox,
select File » Import Appliance from the VirtualBox
menu.

So I began looking at ReactOS's features. One
interesting feature is its multiple desktops. When I
rightclicked the desktop #1 icon on the task bar, I
selected Properties and got this screen.

showing, all right. But it locked up the VirtualBox
session, and locked up my X display session, as
well. I could not regain control of either the hosts's or
the guests's mouse. I restarted the X server and
logged back in to a PCLinuxOS desktop session.

There seemed to be no way to configure the number
of desktops. I selected the equivalent of dxdiag.exe
from the Start menu.
I killed a little time playing Solitaire. The ReactOS
Explorer's behavior is somewhat predictable, but
often artifacts are displayed in the window. I spent
some 15 minutes going through the configuration
tools. They were what you would expect with a
Windowstype OS, but many seemed to have no
function at all (functionality not implemented). Some
implemented settings just would not "stick." I went to
the screensaver settings, selected the Matrix
screensaver, and clicked on Preview. It was

Click Choose button, then select the downloaded
.ovf in the file browser. The VM settings are shown in
the Appliance Import Wizard window. Click Next,
agree to the license and import the machine. Well,
the settings are somewhat different than the ones I
chose. For one, the OS type chosen is
Other/Unknown. Also, the display size was set at 4
MB, so I got this error message when changing the
preconfigured image settings:

It was at this point that I realized ReactOS may need
a more specialized environment than I had given it.
Not being one to give up easily, I deleted the newly
created VirtualBox setup and the created harddrive. I
wanted no confusion with the preconfigured
VirtualBox image I would import. The downloaded
file is ReactOS0.3.11RELvbox.zip. After extracting
I changed the VM settings to 512MB of RAM and
64MB of video RAM and launched ReactOS again.
In my first sessions, installing from iso, I saw that I
had no network connections. Now I did. A quick ping
to Google confirmed this. Whereas I had no system
services running on the last goaround, now I did.
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Although I had basic TCP/IP, I could find no web
browser. Except for basic Windowstype
accessories, Notepad, Paint, etc., I could find no
programs in the menu.
All in all, I found ReactOS to be exactly what the
authors claim. It is an alphaquality clone of
WindowsXP. Not all basic functionality is there yet. I
didn't try any "outside" Windows executables to see
what would happen. I stayed within the confines of
the ReactOS environment to see what it was
capable of "out of the box". I was not disappointed.
This project has come a long, long way from where I
remember it last, some two or three years ago. The
installer is pretty much automated and
straightforward. The OS actually boots and runs. I
would say the developers are on target.

Hmmm, in the C:\ReactOS folder, we see an
explorer.exe and an explorer_new.exe. It appears

the new one is running. The audio output device was
now working, but no mixer controls were found.

To those who may view this as a critique of
ReactOS, nothing could be further from the truth. A
true critique should be installed on a real computer,
not a virtual one. A real critique should include "real
world" tests to gauge the performance of the OS.
None of that is here, because this is simply an article
on how to install the OS to VirtualBox. There are
some who lament that the ReactOS developers are
aiming at a too rapidly changing target. On their
website, they say that "The main goal of the
ReactOS project is to provide an operating system
which is binary compatible with Windows."
Elsewhere on the page, they say XP/2003. Although
I do not agree with their goals, I still admire anyone
who can recreate the functionality of an operating
system FROM SCRATCH. ReactOS underwent a
selfimposed code audit during which all
development was frozen. After the audit was
concluded, the project found no Microsoft Windows
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code in their base. In other words, they really did
start FROM SCRATCH. Quite an achievement, in
my book.
If you would like to check out ReactOS for yourself, I
would recommend downloading the preinstalled VM
image and installing it in VirtualBox. That location,
again, is: http://www.reactos.org/en/download.html.

Screenshot
Screenshot Showcase
Showcase

Answers to Mark Szorady's Double Take:
(1) Hair longer in back; (2) Shirt collar
missing; (3) Shirt stripes different; (4)
Laptop moved; (5) Arm moved; (6) cloud
moved; (7) “Tex” changed to “Texstar”
This month's Double Take features Texstar, a.k.a
Bill Reynolds, the founder and lead developer of
PCLinuxOS. PCLinuxOS was "born" in 2003,
and was initially based on Mandriva. Prior to
that, Texstar had developed and maintained a
special repository of Linux apps for Mandriva.
Today, PCLinuxOS stands on its own, drawing
elements from many different open source Linux
distributions, such as Ubuntu, Fedora,
openSUSE, Mandriva, and many others, as well
as developing some items "inhouse" through
the PCLinuxOS Development Team.

Uploaded by Agust, May 01, 2010, running e17
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ms_meme's
ms_meme's Nook:
Nook: If
If My
My Friends
Friends Could
Could See
See Me
Me Now
Now
If they could see me now that little gang of mine
I'm using PCLOS and doing fine

I'd like those Windows bums to see for a fact

I'm using Linux now and I'm never turning back
All I can say is wow ee look at what I've got
Everything works right on the spot

What a set up holy root they'd never believe me
If my friends could see me now

If they could see me now that little IE group
I'd tell them all the latest PCLOS scoop

I'd hear them ooh and aah with envious sighs
Then they'd tell me that I've been so wise

Then I'd say dear friends you would like it a lot
OK they'd say we'll give it a shot

What a set up holy root I know they'd believe me
If my friends could see me now

Well I've got a new gang and I like 'em a lot
My PCLOS friends they are really hot

To the forum I go when I need support
Everyone there is such a good sport

I meet new friends from all over the map
Try it now what da ya say old chap

What a set up holy root you better believe me

MP3

OGG

We're your PCLOS friends now
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Languages A
A to
to Z:
Z: Lisp
Lisp
by Gary L. Ratliff, Sr. (eronstuc)

program has launched:

We have already had 2 previous articles in this
series which have dealt with the language Lisp. The
first was the E lisp dialect where in we were able to
execute lisp forms from the scratch buffer of the
Emacs editor. And then we had a discussion of using
the Scheme Dialect from Guile.
Lisp, like Fortran, is one of the very first high level
languages developed for computers, and like the
early fate of Fortran, there soon developed many
noncompatible dialects of the language.
The solution to this problem was the same as that
for Fortran: have the language standardized. So the
leading experts of the most used Lisp dialects met
and selected the best features of these dialects, and
agreed on a dialect called Common Lisp. However,
the standard is very broad and there are features
offered in the Common Lips products of the differing
providers.
In this article, we will install and use three of these
products: CLISP, Lispbox, and Lisp Works Personal
Edition. We will demonstrate some very interesting
features of these versions. Each of these has a
separate set of documentation to explore.
Obtaining & Installing the Common Lisp Tools
The easiest to install is the CLISP version, which will
be installed using synaptic. Simply perform a search
for Lisp, mark the CLISP file for installation and click
the Apply button. Once this has been installed, you
will launch the program by entering the command
clisp into an xterm or Konsole screen.
This will result in this display to show that the

By far, the most difficult to install will be the free
edition of the Lisp Works Personal Edition. These
are the steps, as outlined on their website.
1. Read the Release and Installation Notes.
2. Download and run the Lisp Works license script.
3. Download and install the Lisp Works software in
one of these formats:
a. RPM
or
b. tar
4. Download and install Open Motif version 2.2 or
greater.

su
<enter root password>
cd /home/gary/Downloads
sh lwlperlicense.sh
(accept the terms by entering yes when
asked then install)
rpm i lispworkspersonal5.11.i386.rpm
cd /usr/bin
(rename the file to lispw to make it easier
to use)
mv lispworks......... lispw
(this actually creates a symbolic link to
the executable)
(Now when you first execute this file with
lispw you learn that it is looking for a
file named libXm.so.3 you will make version
4 of this library function by creating
another symbolic link.)
cd /usr/lib
ln s libXm.so.4 /usr/lib/libXm.so.3
exit

Now when we run the lispw command we should
see the following:

The Open Motif is obtained via the use of Synaptic.
The provided version will be 2.3. Perform a search
for open motif and select openmotif. This will also
download and install libopenmotif4. Because the
system uses rpm type files, the easiest method will
be to download the RPM version of the file. You can
download the license script and the RPM file. They
will go to the /home/username/Downloads/ folder.
Now become root and cd into this folder.
All examples will use gary as the username:

52

Computer Languages A to Z: Lisp

The third product is Lispbox, which is a modification
of the Lispinabox product designed to be used
with the book Practical Common Lisp. This is
available for several different versions of Lisp for the
x86 Linux family: Allegro 8.1, SBCL, and CLISP
2.36. Now because the text in the book states that
the examples are based on the Allegro
implementation, this is the version we shall
download We will find lispbox at the following
website: http://gigamonkeys.com/lispbox/. Once
here, you may wish to checkout the features offered.
You may start the download by clicking on the line
for the Allegro 8.1 version for i386 linux. This will
place the file: lispbox0.7acl81express.tar.gz to
your /home/username/Downloads folder. The
installation is to simply change to this directory and
execute the command: tar xzvf lispbox<tab>. This
action will create a directory named lispbox0.7. Now
simply cd into this directory and execute the
command sh lispbox.sh. This action will produce
this:

Another method, once the system has been setup,
would be to move to the directory and click on the
lispbox.sh item, which should appear as an icon.
The Documentation for these versions of Lisp
Now that these systems are installed, we will be
ready to explore the documentation to learn how to
use their features. If you check the Documentation
section for the Lisp Works version, you will learn that
the most recent set of files for the linux version was
for 4.5. Since I installed the Windows and the linux
versions, I just opted to use the pdf files from the
Windows version for reading about the features of
this system.
If you are not wanting to read a dry text version,
there is even a comic book version in pdf format to
teach the features of common lisp:

The book, which was designed to be used with the
CLISP version, is called Loving Lisp, or the Savvy
Programmer's Secret Weapon, by Mark Watson. You
will find it at this web site:
http://markwatson.com/opencontent/. Simply move
to the bottom of the page and find the download link.
This will produce a license to accept before the book
is downloaded. The book is in zip format and should
unzip into a pdf formatted text.
The book Practical Common Lisp is, of course, the
documentation which will be used to explore the
features of Lispbox. This book is 32 chapters and
gives a thorough coverage of the dialect. It has
several examples of how to use the features in
making actual systems. The first two chapters
provide a clue as to why you might wish to use Lisp
as their main language.
As with other documentation, this may best be read
using two different screens. Place the text of the
chapter you are reading, and the LispEmacsSlime
in the other. Then, as the text demonstrates the use
of the features, it is easy for you to confirm the
behavior and learn from the immediate feed back.
The chapter on the features offered by the format
form are very interesting. This offers the ability to
have very large numbers written out as cardinals
and ordinals. Also it allows numbers to be expressed
as Roman Numerals.
These are all accomplished with the r variable:
Note how the limit of the conversion to Roman
numerals is 3999, as entering any number 4000 or
larger just yields the number.
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launch Gnu Common Lisp with the command gcl.

There is no lack of materials to help you with
Common Lisp. Also available in the repositories are
the Gnu Lisp version,
available as GCL,
and the Steel Bank
Common Lisp
compiler and runtime
environment, which
is in the repository as
SBCL.

When you consider that the list
of functions available in
common lisp is over 978 item
long and requires 12 pages
just to list, it should be obvious
that this is just a brief
introduction to the world of Lisp
programming.

The photo to the
right is what appears
when you launch
sbcl from a terminal.
Now for the final
picture. Here is what
appears when you
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Creating
Creating A
A Local
Local PCLinuxOS
PCLinuxOS Repository
Repository
by Robert Stahl (Hairyplotter)
Some might ask, "why keep a local repository when
everything you need is available on the internet?"
This is a valid question, and there are a couple of
reasons why someone might want to create one.
First, if you have more than one computer with
PClinuxOS installed, it makes updating, especially
from a fresh install, very fast. If you store your
repository on an external hard drive, you can install
and update machines that might not be connected to
the internet. Or if you're like me, you do it just to say
that you have it.
I am not going to get into specific hardware
configurations. You can store your repository on a
spare computer as long as its connected to the
internet, on an external hard drive or even your
desktop system. The key to automating the process
of synchronizing your repository is that the system
you use is running, connected to the internet and the
partition you choose to store your files is mounted
when cron runs the update script (see below).
Step 1
Plan out the location of your repository and make
sure you have enough free disk space. You can
determine the amount of free disk space you have
on all of your currently mounted partitions by
opening konsole then typing df <enter>.
Filesystem
/dev/sda1
/dev/sda6
/dev/hda
/dev/sdb1

Size
12G
40G
550M
459G

Used
Avail
Use% Mounted on
4.7G
6.6G
42% /
18G
22G
46% /home
550M
0
100% /media/cdrom0
176G 260G
41% /media/Seagate

Since I have 260Gb of free space on my external
hard drive (/dev/sdb1), I will put the repository there.
That will also allow me to update other computers
when necessary.
WARNING: Make sure your repository is away
from any other files and directories. Bury it
under a few directories as I did with
/media/Seagate/Repository/PCLinux/. The rsync
command (see below) will delete any files not
found in the repository you sync with. If you
place your repository in /, it will delete ALL of
your files.
If all you want are the standard repository sections,
(main updates nonfree kde4 games), then you will
need around 15g of free disk space. If you want to
add SRPM (source rpms), then you should have
between 3040g free.
Step 2
Choose a repository close to your geographical
location. Downloading the initial repository is the
longest part of the setup, so I choose to do it in an
interactive session. Doing it this way allows me to
monitor its progress and interrupt it if necessary. The
following is one command, with no line breaks.
rsync aP nomotd stats 
exclude=*testing exclude=SRPM*
spout.ussg.indiana.edu::pclinuxos/pcli
nuxos/apt/pclinuxos/2010/
/home/ftp/pub/linux

* Make sure to replace the bold text with the location
you have chosen to house your repository.

* Remove the exclude=SRPM* if you want the
source rpms.
Once this part is finished, I wrote the following script
and put it in /usr/local/bin, then created a link to it in
/etc/cron.daily* to keep the repository updated daily
and maintain a detailed log of file transfers.
* ln s /usr/local/bin /etc/cron.daily
#!/bin/bash
#[ Change Log ]
# 3/10/2010 Added delete to the rsync
command that was omitted by mistake.
#
Added $REPFILE variable to hold
the location of the repository.
# 5/24/2010 Changed rsync line to reflect
2010 repository layout.
#
#
#
#
#
#[ To Do List ]
#
#
#
#
#
#

# Function to perform some housekeeping
before exiting.
#

function cleanup {
#
# Did we create a temporary file?
if [ f $TMPFILE ]; then
# YES, then delete it before we exit.
rm $TMPFILE
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fi
# Terminate the script with a return code
of 0 (normal termination) or any other
number (abnormal termination).
exit $RETVAL
}
# name the file we are going to log our
output to.
REPFILE="/media/Seagate/Repository/PCLinux"
LOGFILE="/media/Seagate/Repository/rsync.lo
g"
# Create a temporary file.
TMPFILE=`mktemp t rsync.XXXXXXXXXX`
# Was the temporary file created without
errors?
if [ $? ne 0 ]; then
# NO, print a message to our log file then
terminate.
printf "\n********** `date +'[%A %b %d
%Y]  [%r]'` **********\n" >> $LOGFILE
printf "Repository update FAILED: Unable
to create temporary file\n" >> $LOGFILE
RETVAL=1
cleanup
fi
# Set our file counter to 0
COUNT=0
# Call rsync to sync our repository with
spout.ussg.indiana.edu.
# a: This is equivalent to rlptgoD. It is
a quick way of saying you want recursion
and want to preserve almost everything.
# P: Show progress. This isn't very useful
in a noninteractive session, but its nice
when we want to sync interactively.
# nomotd: Most servers have an motd, we
don't need to see it so have rsync ignore
it.
# stats: Give us some extra file transfer
stats. Good during an interactive session.
# exclude=<pattern>: Ignore directories

matching <pattern>. In this case, testing
and SRPM (source rpms).
# logfile=: Log output to the temporary
file we created above.
rsync aP nomotd stats delete 
exclude=*testing exclude=SRPM* log
file=$TMPFILE
spout.ussg.indiana.edu::pclinuxos/pclinuxos
/apt/pclinuxos/2010/ /home/ftp/pub/linux
2>/dev/null
# get the return value from rsync and
assign it to RETVAL for later use.
RETVAL=$?
# Did rsync terminate without errors?
if [[ $RETVAL ne 0 ]]; then
# NO, there was a problem with rsync. Write
a FAILED notice to our log file, then exit.
printf "\n********** `date +'[%A %b %d %Y]
 [%r]'` **********\n" >> $LOGFILE
case $RETVAL in
1)
REASON="Syntax or usage error";;
2)
REASON="Protocol incompatibility";;
3)
REASON="Errors selecting
input/output files, dirs";;
4)
REASON="Requested action not
supported";;
5)
REASON="Error starting client
server protocol";;
6)
REASON="Daemon unable to append to
logfile";;
10)
REASON="Error in socket I/O";;
11)
REASON="Error in file I/O";;
12)
REASON="Error in rsync protocol
data stream";;
13)
REASON="Errors with program
diagnostics";;
14)
REASON="Error in IPC code";;
20)
REASON="Received SIGUSR1 or
SIGINT";;
21)
REASON="Some error returned by
waitpid()";;
22)
REASON="Error allocating core

memory buffers";;
23)
REASON="Partial transfer due to
error";;
24)
REASON="Partial transfer due to
vanished source files";;
25)
REASON="The maxdelete limit
stopped deletions";;
30)
REASON="Timeout in data
send/receive";;
35)
REASON="Timeout waiting for daemon
connection";;
*)
REASON="Undefined error";;
esac
printf "Repository update FAILED with error
code $RETVAL: $REASON\n" >> $LOGFILE
RETVAL=2
cleanup
else
# YES, rsync finished without errors.
# get the number of package files
transferred.
TRANSFERRED=`cat $TMPFILE | grep c .rpm`
# Were any files transferred durning this
update?
if [ $TRANSFERRED gt "0" ]; then
# YES, we had some files transferred.
# Add a note to the logfile detailing the
current time and the number of files
transferred.
printf "\n********** `date +'[%A %b %d
%Y]  [%r]'` **********\n" >> $LOGFILE
printf "Repository update SUCEEDED with
$TRANSFERRED files transferred.\n" >>
$LOGFILE
printf "Number\tSection\t\tFilename\n" >>
$LOGFILE
echo "
" >> $LOGFILE
else
# NO, there were no files transferred
durning this update.
# No need to add a note to the log file.
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# Call the cleanup function which will
terminate this script after some
housekeeping.
RETVAL=0
cleanup
fi
# Since we had some files transferred, we
will parse our temp file line by line to
get the filenames.
cat $TMPFILE | while read line
do
# Does this line have .rpm in it (denoting
a package file)
FILE=`echo $line | grep .rpm`
if [ ! z "$FILE" ]; then
# YES, lets increment our counter by 1 then
write that number along with the section
and filename transferred to our log file.
COUNT=$(($COUNT+1))
FILE=`echo $FILE | awk '{ print $NF }'`
SECTION=`echo $FILE | cut d'/' f3`
FILENAME=`basename $FILE`
printf " $COUNT:\t$SECTION\t$FILENAME\n"
>> $LOGFILE
fi
done
fi
RETVAL=0
cleanup

Step 3

Now that I had the repository downloaded and ready
to go, I needed to set up an ftp server to make the
files available to all of my machines.
I started by installing vsftpd from the repositories.
After doing some reading on the vsftpd configuration
file, I opened /etc/vsftpd/vsftpd.conf with kwrite and
added:

* Change the text for anon_root= to the location of
your FTP.
# Allow anonymous FTP? (Beware  allowed by
default if you comment this out).
# I want a read only anonymous ftp.
anonymous_enable=YES
anon_root=/home/ftp
anon_upload_enable=NO
anon_mkdir_write_enable=NO
anon_other_write_enable=NO
anon_world_readable_only=YES

* NOTE: 192.168.1.105 is the IP address I manually
assigned to my spare machine. I used FTP as my
means of serving the repository, but its not the only
method available.

cmds_allowed=PASV,PWD,LIST,TYPE,MKD,CWD,EXI
T,QUIT,HELP,RETR
pasv_min_port=10450
pasv_max_port=10500
pam_service_name=vsftpd
userlist_enable=YES
tcp_wrappers=YES
use_localtime=YES

I set vsftpd to start when the computer is turned on
through PCC > System > Manage system services
by enabling or disabling them.
I opened Synaptic on my other machines, and went
to "settings" > "repositories", unchecked the default
repository, then clicked "New."
URI: 192.168.1.105/pub/linux
Distribution: pclinuxos/2010
sections: main updates nonfree kde4 games

Click "Ok", then "Reload." You should now have your
very own PCLinuxOS repository that keeps itself up
to date.
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GAME ZONE:
ZONE: Warzone
Warzone 2100
2100
by AndrzejL

good to go and happy as a puppy.

I was messing around with my machine sometime
ago. I was bored. Really bored. I decided to find
myself something that will entertain me for the rest of
the day, so I have started browsing the web, hoping
to find something really interesting there. Different
search terms. Different websites. Finally I have
found a website about an opensource games.
That's it I said. I am gonna install a game for myself.
But which one? Torcs? Already installed. Some
shooters? No thank you. And all of a sudden ...
BOOM! Warzone2100! What's that? Wikipedia
answers this question better than I would ever do.
According to Wikipedia, Warzone2100 is “an open
source realtime strategy and realtime tactics hybrid
computer game.” More about it can be found here:
http://en.wikipedia.org/wiki/Warzone_2100.

After installation, the game can be found in Kmenu >
Games > Strategy > Warzone2100. Click on the
entry to start it.

Basically, it's this: It's a free “Starcraft” or “Warcraft”
kind of game, originally developed by “Pumpkin
Studios” and published by “Eidos Interactive.” The
first time the world saw it was in 1999, and it was
originally released for Microsoft Windows and
PlayStation only. Nowadays, its available for Mac
OS X, Linux and other OSes too.
It was a commercial game at first, but in the end of
2004, it was released under the GNU General Public
License. WOW I said. Way cool! Now I hope that it's
not big and that its easy to install, because I don't
want to spend the rest of the day downloading it and
struggling to install. WOW number 2! Well, it's about
13 MB download, and what is even better, it's
available in the PCLinuxOS repositories. That makes
it really easy to install via Synaptic, just like
everything else. Way cool! I had to have it. I have
started installing it, and few minutes later, I was

few audio and video options, as well as some
gameplay options. Done? Great – time to start. If
you are a beginner, the game offers a tutorial
episode. Just follow the instructions to learn the
basic rules of the game.

From Wikipedia, you can find out that the story goes
like this:
“In the late 21st century, the world's civilizations are
wiped out by a series of nuclear strikes. While most
of the survivors form scavenger bands to survive,
one group of people, who refer to themselves as
"The Project," seeks to rebuild civilization using pre
war technology.

Here the game opens in a full screen view and after
a short demo the menu is shown. We can choose

The game begins with the Commander, the
protagonist, sending teams to gather technology in
Arizona that would help with reconstruction. While
gathering said "artifacts," the Project fends off
attacks from an organization called the New
Paradigm, which is under the command of an
organization called Nexus, which is actually one
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man responsible for the nuclear war. In the final
campaign, the Project launches a fullscale assault
on Nexus, destroying it and thus removing all
significant, organized barriers to its reconstruction of
the Earth.”

In my own words? You start with a few units, 3 trucks
and few destroyers. You have to build a base and
defend it. Gain control over power sources.
Research new weapons/buildings/units from the
found artifacts. Destroy enemies. Conquer new
places. Sounds like fun? It is fun.
Wikipedia gives more information about the game:
“A New Paradigm dropship takes off after deploying
an assault force against the Project.
The game is fully 3D, based on the iViS games and
3D graphics engine developed by Sam Kerbeck of
Eidos. The terrain is mapped by a grid; vehicles tilt
to meet hilly terrain, and projectiles can be

realistically blocked by steep mountains. The
camera is freemoving and can zoom in and out,
rotate, and pan up or down while navigating the
battlefield.
In the game, units of different factions are painted
different colors. The New Paradigm, the Collective,
and Nexus are the enemies of the Project in the
campaign, and they can be seen attacking Project
forces as well as Scavengers, survivors of the
nuclear fallout.

Units can all be customized according to: chassis
(which, for example, takes weight and power into
account); drive system (such as wheels or tracks);
and mounted object (such as a weapon, or one of
various support tools). Units can level up from ranks
such as Rookie to Trained and Professional.
Mobile mortar weapons bombard Scavenger
occupied shacks from afar.

Warzone 2100 places an emphasis on sensors and
radar to detect units and to coordinate ground
attacks. Counterbattery sensors detect enemy
artillery by sensing their projectiles and firing arcs
and pinpointing their location to coordinate artillery
strikes against enemy artillery. VTOL sensors work
like basic sensors, only they coordinate VTOL
attacks. VTOL counterbattery sensors coordinate
VTOLs to find and destroy enemy batteries.
There is an emphasis on artillery: although many
direct and closecombat weapons and antiair
weapons can be researched and deployed, artillery
is a staple of assault on enemy bases and
outposts.While the technology tree is clearly defined
and consistent, it never appears ingame and,
therefore, the player can be left guessing as to what
technology is next in the tree. Technology can be
acquired by gathering artifacts left behind by certain
destroyed enemy structures or units. Researching is
composed of largely small and incremental
advancements over existing weapons, armor, and
chassis types.
Videos frequently appear during gameplay. This
image depicts a dropship transporting the player's
forces towards the campaign's first Away mission.
Every level, excluding the first and last, has a time
limit. This gives a sense of urgency and keeps
players from waiting very long to gather more
resources for unit construction. However, in Away
missions, the player must select a limited group of
units to transport to a territory completely away from
the original base.
All of the terrain throughout the campaign is
essentially composed of three areas, with different
sectors for Away missions and other such levels;
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upon progression, previous maps simply expand
and the player's original bases from past levels are
maintained. Also, its resource system is quite
different from mainstream RTS games; Oil Derricks
are established over specific, scarce locations which
constantly provide a slow, fixed rate of income.
Combined with a mission time limit, this resource
method prevents players from simply waiting for long
periods of time to amass surplus resources and
ridiculously large armies using traditional RTS
tactics.”

Disclaimer

Operating system  one of:
Windows 2000 or higher
Mac OS X 10.4 or higher
Linux or BSD
You will most likely need the latest version of the
drivers for your video card.

1.

2.
3.

4.
5.

System Requirements
Recommended minimum hardware:
~1 GHz CPU
64 MB graphics card with good OpenGL support
(make sure you have the newest drivers installed)
~ 100 MB free RAM for the game
~ 100 MB HD space for the game, up to ~ 600 MB
extra for the large videos

All I can add is that the game is really likable. It
looks great and it's a lot of fun.
I don't think you will regret installing it.

All the contents of the NEW PCLinuxOS Magazine are only
for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.
The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.
The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.
No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.
Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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It's easier than e=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
Uploaded by Redeemed05, May 09, 2010, running LXDE
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How
How II Finally
Finally Made
Made My
My Slide
Slide Show
Show
by Smileeb
My niece got married on December 02, 2009. I
promised her a slide show of the pictures people
took and sent to me so they could be added. The
slide show ended up with 350 pictures and music all
the way through. I tried different things members of
the forum explained to me but, being inexperienced
in doing this type of project, nothing seemed to work
as I thought it should.
I used two different slideshow programs, because I
made the promise, and because the Linux one failed
me at the time. I first used my daughter's Windows
computer that had Photodex Proshow on it. The
program allowed the installation of the pictures and
music, but didn't have the extras that Imagination
has.

After many attempts at different conversions and
burnings, I ended up with this one by taking the .vob
file made by Imagination and loading it into WinFF.

I ignored the info box and clicked on the burn button.
It gave me a fantastic slideshow that played on my
home viewer. I hope this will help others in their
attempts in making slideshows to give to friends to
play on their home TV. The nice thing about this is
the Windows application I had uses DVDs, and with
this I can use CDs.

When using WinFF, if the size of your vob exceeds
700MB, then select DVD instead of VCD. Be sure
you pick the right device preset for your area, either
NTSC or PAL.
This converts the file to a Good Mike & Di
Wedding.mpg. You can then take this file and open
K3b, and you will get this and the info box.
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Testimonial:
Testimonial: A
A PCLinuxOS
PCLinuxOS Journey
Journey
by Terrick Wright (newklear)
I first stumbled upon PClinuxOS after much trial and
tribulation with other Linux Distributions, such as
Ubuntu (which is incidentally our National Linux
Distribution paved by Mark Shuttleworth and
Canonical here in South Africa), Puppy Linux and
then PCLinuxOS, which I found here at Distro Watch
(www.distrowatch.com).
I installed 2009 LXDE as my first introduction to
PCLinuxOS, and "Wow, oh wow," it was amazing :)

Replacement of Windows XP Professional and
Windows 7. There are just so many packaged
programs that are available in the Synaptic Package
Manager that I dare not say how much. (It's a well
kept secret that there are 30,000+ programs
available).
First person I showed PCLinuxOS to was my
grandmother, who is racing to her Century. I sat her
down in front of PCLinuxOS 2009 LXDE, and
showed her where the PCLinuxOS Start Menu was

From the moment that I booted off of the download
ISO turned into LiveCD, the experience was
actually so much fun! I could not wait for the next
step to come along. By that I mean, everything was
so straight forward and simple. PCLinuxOS sure
does keep to its principle of Simplicity with awesome
functionality.
When I was initially downloading the ISO, I took the
time to read through the forum link that was on the
main PCLinuxOS page, and noted that the best
practice for install was to do a system update
through a package manager called Synaptic
(Woweee, I know of Synaptic. Who doesn't, right?).
Right after the update, which was 170'ish odd
megabytes, I installed a few games (doesn't
everyone do that?), and I was really impressed with
the available games. I was so happy to even see a
build of the infamous and legendary game, Sid
Meier's Civilization. After installing a few games
(Solitaire just had to be one of them), Abiword
extensions (what an amazing word processor) and
Anjuta2 (IDE replacement for Visual Studio on
Microsoft), I had a full complete Desktop

time she hosts Book Club. Since then, we have
made no less than 11 CD copies for others to use.
Most people worry about support if something
happens to go wrong, I was actually overwhelmed
on how well set up and readable the PCLinuxOS
forums were. Browsing through the various sections
was very easy.
There is a wonderful control panel called PCC
(PCLinuxOS Control Center), which is yet again so
simple and straight forward to use. PCLinuxOS is
once again Simplicity.
I also have to mention, and what totally sealed the
deal, was that all of a sudden, with the new 2010
PCLOS Kernel release, our Huawei ETS 2258
Modem operated without any udev rules, or anything
such whatsoever. Was just a matter of dialing up!
This was the first Linux distribution that took the time
to read our posts and implement them in new
updates. You cannot begin to imagine how that
makes me feel as a user. Thank you so much
Texstar.

(just the same as the START button in Windows).
She clicked, clicked again, and was A and away.
Very simple. The first games she played were the
lovely card games you get, and she managed to
browse through hundreds of various card games. My
grandmother was my first PCLinuxOS convert. It's
not only a wonderful topic starter to mention "my
grandmother uses Linux," but also to know just how
trusting people are of Grannies. My grandmother did
all the converting in my household to be honest. We
now run two desktop PC's and two laptops, all
running various flavors of PCLinuxOS. I will definitely
produce a few CD's with PCLinuxOS for the next

Have we looked back or regretted anything? Nope,
none at all. We were even able to get a printer and a
network card (NIC) that did not work before to run
flawlessly. Running PCLinuxOS over the past few
months has only brought joy and happiness in our
family. In life, it is the teenytiny special things that
bring joy and satisfaction to our hearts. Thank you to
the developers and contributors to PCLOS, all of us
sure do make a special family.
I believe credit due to everyone that has made such
a wonderful, lifealtering OS. Give yourselves a pat
on the back. Job well done.
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DJL:
DJL: A
A Linux
Linux Gamer's
Gamer's Paradise
Paradise
by J. C. Little (TuxTorch)
DJL is a game manager written in Python for the
GNU/Linux Operating System, inspired by Valve's
Steam software for Windows.
The description for DJL, from Synaptic, is as follows:
A game manager inspired by Steam from Valve software.
djl is an opensource (GPL licensed) game manager
written in Python for the GNU/Linux Operating System,
inspired by Valve's Steam software for Windows.

It makes it possible to download, install (via a repository)
and remove a large number of games placed in a
subdirectory in an absolutely invisible way (but without
dealing with any dependencies).
It can also execute .desktop shortcuts located in another
directory (this way, it's possible to launch games which
were already installed).
Several games are available in the repository. Anyone can
submit new games to developers via a web page
(http://djl.jeuxlinux.fr/djl_addgame_en.php).
This program provides a list
of games with their
screenshots and
descriptions.

It will also download the game selected and
automatically install it for you.
Once the game is downloaded click on the games
tab to see a list of your installed games and double
left click to launch the game.
There is also a chat section for logging into their
official IRC channels, so you can request games to
be added etc, within the same program.
The news section contains a updated list of what’s
been added or updated!
So if you’re new to gaming in Linux and don’t know
where to turn, then check out DJL. I can guarantee
you’ll be playing your favorite type of game in no
time!
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More
More Screenshot
Screenshot Showcase
Showcase
Top Left:
Uploaded by
Archie,
May 06, 2010,
running KDE 4.
Top Right:
Uploaded by
Meemaw,
May 19, 2010,
running KDE 4.

Bottom Left:
Uploaded by
TommyLee567,
May 08, 2010,
running KDE 4.
Bottom Right:
Uploaded by
sammy2fish,
May 02, 2010,
running KDE 4.
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